Moving from Land Desktop to Civil 3D
Chapter 5  **Adopting Civil 3D Project Management**

- Organizing Your Data ................................................. 95
- Data Storage: Vault or Not ........................................ 96
- Drawing and Object Relationships ................................. 97
  - Level 1: Individual Design Objects ............................. 98
  - Level 2: Base, Linework, and Engineering Drawings ....... 99
  - Level 3: Production Sheets .................................... 100
- Sample Project Structure ........................................... 102
- Data Reference Types ............................................. 103
  - Autodesk Vault Overview ...................................... 103
    - Vault Project Structure ..................................... 103
    - Advantages of Autodesk Vault ............................... 104
    - Limitations of Autodesk Vault .............................. 105
    - Best Practices ............................................. 105
    - Sample Uses .................................................. 105
  - Data Shortcuts Overview ....................................... 105
    - Advantages of Data Shortcuts ................................. 106
    - Limitations of Data Shortcuts ............................... 107
    - Best Practices ............................................. 107
    - Sample Uses .................................................. 108
  - External References Overview ................................. 108
    - Advantages of Xrefs .......................................... 108
    - Limitations of Xrefs ......................................... 109
    - Best Practices ............................................. 109
    - Sample Uses .................................................. 109
- User Access Controls ............................................... 110
- Project Folder Structure .......................................... 111
- Working Folder Location .......................................... 113
- Sharing and Transferring Files .................................. 113
- Autodesk Vault Setup ................................................ 114
  - Single or Multiple Sites ........................................ 114
  - Creating Additional Vaults ..................................... 117
    - Single Vault .................................................. 117
    - Multiple Vaults ............................................. 118
  - Project Folders .................................................. 118
  - Working Folders .................................................. 118
    - Working Folder Configurations .............................. 119
- Autodesk Vault Project User Interfaces ......................... 121
  - Prospector Tab .................................................... 122
- Autodesk Vault Administration Tool .............................. 122
- Microsoft Office ................................................... 124

Chapter 6  **The Next Move** ........................................... 125

Contents | v
Index ........................................... 127
Getting Started

This guide is intended to help you transition from using AutoCAD® Land Desktop to using AutoCAD® Civil 3D® as your primary engineering design application. It will help you understand the many benefits of moving to Civil 3D, how your current workflows may change as a result of the move, and how to prepare for the move.

If you are a civil engineer, designer, surveyor, drafter, or CAD manager who is moving to Civil 3D, or considering moving to Civil 3D, this guide will help you assess the overall process involved.

Why Move to Civil 3D?

Perhaps your organization has already made the decision to move from Land Desktop to Civil 3D. If so this chapter reinforces why that decision was the right one. If your organization is still in the process of evaluating whether it should move from Land Desktop to Civil 3D, this chapter will help you understand the compelling arguments for doing so.

The following sections describe some of the important benefits you’ll realize by moving from Land Desktop to Civil 3D.

Dynamic Model-Based Design

Projects created with Civil 3D use a dynamic engineering model that links design and production drafting. As a result, a change to one part of the design propagates throughout the entire project, greatly reducing drafting errors as well as the time it takes to implement design changes and evaluate multiple design scenarios. For example, if you adjust the vertical design alignment, Civil 3D automatically updates the road model, redisplays proposed contours, recalculates volumes, updates profile labels, and corrects section plots for the road. If you change the curve length on your alignment, the profile, corridor model, and plotted cross sections are all updated. If you lower a building pad, you can immediately retrieve updated volumes and display the new limits of...
construction. Civil 3D effectively maps the civil engineer's work process into an easy-to-use and powerful software environment, saving time and money, and reducing errors.

**Better Control of Standards**

Civil 3D allows you to easily deploy and automatically enforce organizational standards for design data by employing style features that are built directly into drawing templates (*.dwt files).

A variety of drawing templates with predefined styles comes with Civil 3D. These can be used as a starting point for creating your own custom templates and styles. Typically in an organization, custom drawing templates are created and maintained either by one or by a few persons, and shared with the team or teams. A CAD manager can store the templates in a read-only location where the rest of the team can access and use them, but not modify them.

When new styles are needed, it is just a matter of updating the template from the current drawing, or updating the current drawing from a template. New styles can be dragged from one drawing into a template using the Civil 3D Toolspace. Chapter 3 (page 69) of this guide discusses the use of styles and templates in more detail.

**Cutting Edge Technology**

At the time it was introduced, Land Desktop represented best in class technology for automating standard engineering processes. Many organizations have been using Land Desktop for as long as a decade, proving that it is a dependable platform for creating construction documents for the civil engineering industry; however, the technology platform on which Land Desktop is designed has evolved to its limit.

Civil 3D was built from the ground up to be completely integrated with AutoCAD—the world's most widely used CAD platform. It is designed to support all types of civil engineering projects, from site design and local roads, to major highways and interchanges, and utilizes three-dimensional, dynamic, model-based design technology. This advanced technology provides you with a whole new set of tools and workflows that will let you create and evaluate designs faster and more precisely.

**Increase Design Alternatives**

The Civil 3D dynamic engineering model lets you explore conceptual proposals and complete final designs faster than in Land Desktop. For example, you can begin by quickly laying out various alignment alternatives for a proposed roadway. You can then begin refining alignments, profiles, and the makeup
of the roadway cross section until the best design proposal has been developed. With each change, all related objects and drawings are updated automatically. This functionality allows you to evaluate more design alternatives in less time, providing your customers with a higher level of service and differentiating your firm from the competition.

**Create Plan and Profile Sheets Faster**

Civil 3D provides an environment where drafting is derived directly from the model using display styles. The style-based environment helps to ensure that objects and annotation in the drawing conform to production standards. Civil 3D also provides civil/survey-specific drafting tools and advanced drafting features, such as the Plan Production Tool wizards for roadway sheet generation. Tools such as these automate what would typically involve numerous steps in Land Desktop, resulting in improved production drafting efficiency.

**Dynamically Link Designs with Production Drafting**

Civil 3D dynamically links drafting elements, such as alignment or parcel labels and tables, with the engineering model so that a change to any part of the model produces updated annotation automatically. These intelligent labels and tables also reflect any changes in the drawing scale and view orientation. For example, if you change the scale of the plan from 1:50 to 1:100, the annotation automatically resizes to maintain the proper size in completed construction documents. If you rotate the view orientation of the plan, the annotation of the objects automatically rotate to maintain plan readability. Automatic updating minimizes time-consuming and costly manual editing of drafting elements and helps ensure the accuracy of your final construction documentation. This minimizes the need to redraft when design changes occur. After your drafting is generated, the model and Civil 3D annotation remain in sync.

**Advanced Data Sharing and Project Management**

Civil 3D has scalable, multiuser data sharing and project management functionality that includes the use of AutoCAD xrefs, data shortcuts, and project management support based on Autodesk® Vault. These features help small and large project teams complete projects more quickly and with less risk of errors. Multiple members of a design team can access items such as survey observations, points, surfaces, alignments, profiles, corridor models, and pipe networks so that multiple people in different departments can work on a project simultaneously. You can share an alignment across multiple drawings—while each drawing has different annotation and object appearance.
If the master alignment changes, the alignment in all your secondary drawings is updated automatically. There is no need to re-create any drafting—plan and profile remain in sync. By using one or more of these features, everyone on the team can work on files simultaneously, and be assured that everyone is using the most up-to-date project data.

**Data Compatibility**

You can use Civil 3D to work with any DWG™ drawing files, read and write MicroStation® DGN drawing files, and import and export Land Desktop project data. Civil 3D also works with LandXML data and GIS data formats, including ARC/INFO® coverages and Export (E00), ArcView® Shape, and more, allowing you to do conceptual studies using free or low cost data from various sources. You can also use Civil 3D to export model graphics and metadata for use outside of Civil 3D. For example, a published DWF™ file includes all of the model data, such as pipe size and material, so that people reviewing the design in Autodesk® Design Review can have all the information they need to validate the proposal.

Using Civil 3D, you can export model elements, such as parcels, pipes, and alignments, to SDF format for use in GIS applications, such as AutoCAD® Map 3D, Autodesk MapGuide® Enterprise, or Autodesk® Topobase™ software. Civil 3D also supports interfacing with the industry-leading data collectors from companies such as Leica, Trimble, and Carlson. Civil 3D data compatibility creates an integrated CAD and GIS solution that makes it easier to work with both internal and external engineering and GIS departments or consultants.

**Visualization and Rendering Features**

Civil 3D includes all of the rendering capabilities of AutoCAD software. These features help you quickly communicate design proposals. For example, drawing elements representing roadway components can be rendered with specific materials so that they automatically render a particular surface or subsurface material. Surface models can be easily broken into subareas that display as different materials. The rendering features are easy to use and handle a range of detail, from simple shading to photorealistic images. Civil 3D also includes utilities to help you integrate your design models into the Google Earth™ mapping interface for quickly communicating design intent to nontechnical audiences.

Because Civil 3D is built on AutoCAD software, experienced AutoCAD users can work in a familiar environment, with tools and processes they already know, while also taking advantage of the engineering, surveying, and industry-specific drafting tools that are native to Civil 3D.
Civil 3D Features and Benefits

This section discusses in more specific terms some of the key Civil 3D design features that will provide significant benefits compared to Land Desktop.

Better Project and File Management Features

Unlike the project management solution in Land Desktop, the project management solution in Civil 3D is a scalable, comprehensive multi-user project management system that provides project teams with appropriate levels of access to the data they need. It facilitates the organization of files, distribution of files over a network, version control, check-in and check-out, and rollbacks. Civil 3D includes a range of file management features that suit varying levels of project management needs—from drawing-based shortcuts and xrefs to the full-scale project management solution features.

The Civil 3D project management solution leverages the data management capabilities of Autodesk® Vault to allow project teams to work more efficiently and with less risk of coordination errors as modifications occur in the project cycle. For more information about the project management solution in Civil 3D, and how to integrate these features into your workflows, see Chapter 5, Adopting Civil 3D Project Management (page 95).

Improved Point Features

Create points using a variety of coordinate geometry (COGO) and graphical methods. Because Civil 3D points are a part of the engineering model, and not maintained in an external file, changes made to the points are dynamically reflected in the model. For more information about Civil 3D point functionality, and how it compares to Land Desktop point functionality, see Chapter 2, Comparing Land Desktop and Civil 3D (page 15).

Improved Surface Features

Build surfaces from a variety of 3D source data. Analyze contours, slope, elevation, and watershed areas, and update contours, volumes, and surface analysis instantly when making surface edits. Civil 3D updates surfaces when data is added or edited, and rebuilds the surface when data is removed. For more information about Civil 3D surface functionality, and how it compares to Land Desktop surface functionality, see Chapter 2 (page 15).
**Improved Parcel Features**

Dynamic relationships mean that parcel collections are always up-to-date. Civil 3D integrates parcels that are within a single site topology, so a change to one parcel creates related changes in neighboring parcels.

**Improved Alignment Features**

The Civil 3D alignment object includes tangent, curve, and spiral features and enables the addition of any labeling required in the finished plans. You can edit using a tabular editor or graphical interface to automatically update the alignment's labeling. You can also share alignment and profile data across drawings for use by multiple project team members. For more information about how you work with alignments in Civil 3D, see Chapter 2 (page 15).

**Improved Profile Features**

Extract profiles of multiple surfaces based on alignment geometry, automatically control the profile appearance and annotation based on the styles that you select, and update profile labeling and drafting dynamically. For more information about how you work with profiles in Civil 3D, see Chapter 2 (page 15).

**Improved Corridor Modeling Features**

Generate a dynamic model of any road, rail, or corridor project by using design elements—such as alignments, profiles, superelevation, and other design criteria—that can apply constraints and other customized behavior into the model. Changes made to the elements that were used to create the model result in updated corridor volumes, surfaces, sections, and other analysis and output. Civil 3D provides real-time editing of individual stations or station ranges along the road. Civil 3D also has an intersection creation wizard that allows you to create three-way and four-way intersections, with dynamic offsets, and dynamic curb returns, in just minutes. These are just some of the advanced road modeling features that are only available in Civil 3D.

**Improved Subassembly Catalog**

Civil 3D provides you with a catalog of over 100 preconfigured subassemblies of typical roadway components such as lanes, curbs, sidewalls, ditches, rails, and even a basic bridge. You can use these as is in your model or use them as starting points to design your own catalog of custom components for typical roadway sections (assemblies). You can even insert “conditional” subassemblies that automatically insert the appropriate roadway components or behaviors at various stations, such as ditches, guardrails, or daylighting, when certain...
conditions exist. They are easily accessible from a convenient tool palette that includes graphical representations of the shapes.

**Improved Section Features**

Extract and draft surface and corridor sections. Select sections at specific stations, at intervals along alignments, or at specific points, and create section plots for a single station or full section sheets.

**Improved Site Grading Features**

Combine multiple grading elements into one group to find solutions for complex grading problems. Grade to surface, elevation, or distance targets. Balance cut/fill volumes dynamically for an entire site or a single grading object. Build a static or dynamic surface from grading groups. While similar tools exist in Land Desktop, you will quickly find that the way they function in Civil 3D is simpler, more intuitive, and more feature-rich.

**Improved Pipe Features**

Lay out sanitary and storm drainage systems as dynamic, interactive pipe networks. You can make changes to pipes and structures using graphical as well as numeric input. Changes to a pipe network automatically update the drafting (labels). You can plot and complete final drafting of the pipe network in plan, profile, and section views, and you can use rendering and visualization features to produce realistic representations.

In addition, an easy-to-use graphical interference-checking feature lets you quickly identify pipe network parts that collide with each other or exist in undesirable locations. You can also share pipe network information, such as pipe and structure material and size, with external analysis applications.

**Hydraulics and Hydrology Features**

Civil 3D includes three software extensions that enable you to perform storm water hydraulics and hydrology tasks, including storm sewer design, watershed analysis, detention pond modeling, and culvert analysis.

The Hydraflow Storm Sewers Extension is a comprehensive solution for watershed analysis and detention pond design, from simple sites to complex watersheds with interconnected ponds. You can automatically design pipes, inverts, slopes, and inlets based on user-defined parameters, and interactively modify and optimize your system in real time, assuring that your Civil 3D designs have the highest hydraulic efficiency at the lowest possible cost.
The Hydraflow Hydrographs Extension is used for pond design and modeling of simple or complex watersheds using the SCS and/or Rational methods. You can perform a host of functions, including hydrograph combining, channel reach and reservoir routing, and hydrograph diverting.

The Hydraflow Express Extension provides flexible calculators for performing a wide variety of hydraulics and hydrology tasks for designing culverts, open channels, inlets, hydrology, and weirs. You can quickly produce informative graphs, rating curves, and professional, easy-to-read reports.

These three extensions come with Civil 3D. They bring easy-to-use, industry-leading hydraulics and hydrology software to Civil 3D users, providing significant productivity improvements over Land Desktop hydraulics and hydrology features, as well as providing additional features that are not present in Land Desktop.

**Improved Survey Features**

The survey features in Civil 3D provide a consistent environment for performing survey tasks such as using the Survey Data Collection Link to convert raw data to field book files for importing, as well as functionality for least squares adjustment, editing survey observations, and reporting tolerance errors. The Import Survey Data wizard allows you to create a survey database and network on the fly and also has options for importing field book files, LandXML data, point files, or points in the drawing. With the Mapcheck Analysis command, you can check survey figures and parcels for closure, based on label direction and distance values. The Mapcheck Analysis command can also be used to check manually input data for closure errors, and to subsequently adjust and create AutoCAD polyline objects. Editing survey figures is simplified by using feature line editing commands available from the ribbon.

**Preparing for the Move**

This section describes the items you should consider before you move from Land Desktop to Civil 3D.

**Assessing Current Workflows**

The first step in moving from Land Desktop to Civil 3D is to assess your organization’s current workflows for designing and delivering engineering design projects. A clear understanding of your current workflows and processes will help you implement Civil 3D software successfully and be better able to
validate results. For example, is your current workflow documented in any way, either at a conceptual or detail level? You might want to consider at least diagramming your current workflow, at a conceptual level, as you assess it. This step will help you as you begin your transition from Land Desktop to Civil 3D.

An important aspect to consider is how or whether your organization utilizes IT or CAD management resources. For example, in your organization, do you have specific individuals who are responsible for installing and maintaining tools and software? Do you have one or more individuals responsible for maintaining your company's drawing standards?

This is an important aspect to consider because, depending on the size and complexity of your organization, you may need to schedule IT and/or CAD management resources during the Civil 3D implementation phase.

Choosing Pilot Projects

The next step is to determine which project or projects in your organization are the best ones to use as pilot projects. Choosing a pilot project that has the following characteristics will help make the process of learning to use Civil 3D go smoothly. It may be best to choose a project that:

■ has a straightforward design that your company is familiar with
■ has a flexible and willing client—if you choose billable projects
■ is a smaller job

In other words, a large master-planned community for a new client, in a location your organization is not familiar with, is probably not the best project to use as your first Civil 3D pilot project.

There are two general approaches to consider when deciding how to implement your pilot projects: using completed Land Desktop projects, and starting new projects from scratch. The first approach, using completed Land Desktop projects and recreating them using Civil 3D, can provide you with the following benefits:

■ The timeline for the pilot project is not tied to a client deadline or milestone; in other words, the end date is open-ended.
■ Encountering any unforeseen problems during this pilot effort has no impact on client-related deliverables.
There are no budgetary constraints other than accounting for the non-billable time spent training.

There is less pressure on team members.

However, there are some drawbacks to consider when using existing Land Desktop projects as a pilot projects:

- Without a timeline and the rush of client demands, many people find it hard to work effectively and with their usual level of detail.
- Because you are not creating a design from scratch, but rather re-creating an existing design, some portions of the design process might not be fully explored using this type of pilot, leading to a false sense of security.
- Using existing Land Desktop projects does not allow you to gather real-world metrics on design and production timelines for measuring the success of Civil 3D in a real-world project environment.

When you use the second approach—starting a new project from scratch in Civil 3D—the experience presents a broader spectrum of real-world issues and scenarios. A real-world billable project will allow you and your team to learn how to better deal with the actual design process, plan production, change orders, and plan reviews.

**Dispersing Knowledge**

Your pilot projects will lead the way in how you train others in your organization to use Civil 3D as a design platform. The following are some different methods to consider for dispersing the knowledge gained from working on pilot projects:

**Rotating Pilots**—Using this method, each design team is trained one at a time, with one group following another. This allows a group of individuals to be trained on an entire project in Civil 3D before moving on to train the next group of individuals. It is highly recommended that each design team complete a basic level of Civil 3D training before they begin a pilot project. Using this method typically means training to various levels, and covering the full extent of the product in every pilot project since each team will be new to Civil 3D. This process can be expensive because expert-level trainers would be used for each team. However, with this method, because each group except the first one will have coworkers that can provide guidance to others, the learning curve for each subsequent group should lessen.
**Shared Knowledge Pilots**—Using this method, the initial project team consists of individuals who have already completed basic Civil 3D training, and who are using a pilot project as advanced training. This team completes the first pilot project, developing standards, styles, operating practices, and templates along the way. After this project is complete, this group disseminates knowledge to the next group. These team members then become responsible for teaching the basics to the next generation of users, honing their own skills in the process. This method can be less expensive than rotating pilots, but can also result in a slower adoption rate, and a higher risk that individuals may not be learning all of the best practices and techniques that they could be learning.

**Hybrid Pilot**—This method combines some characteristics of the previous two methods. A hybrid pilot methodology typically includes basic training for an initial group of individuals from an expert-level, third-party trainer. This team completes a pilot project, working in tandem with a trainer to build styles and standards in preparation for more widespread Civil 3D deployment. After this first pilot project is complete, these individuals are then used with the expert as a training core, rotating through remaining teams and acting as mentors for peers.

With this approach, the first generation of individuals learns how to use the product while having the trainer immediately available for assistance if needed. Because this method allows local users to be more involved in the training of the next generation of users, more customization based on skill levels is possible.

By reviewing your goals for implementation speed and cost, you can decide on a pilot and training methodology and begin detailed planning for your user-based training.

**Understanding Training Resources**

Whether it’s time spent learning how to use the product on your own, or time spent attending an offsite or onsite training class, make sure that your pilot project strategy includes the appropriate amount of time for individuals to learn how to use the Civil 3D software.

The following sections describe a variety of training resources that are available for learning how to use Civil 3D. They include:

- Civil 3D product documentation
- Autodesk training programs and products
Civil 3D Product Documentation

You’ve already taken the first step by reading this book. After reading this book, you should peruse the other documentation components available with Civil 3D. They provide both the information you need to get started using the software and complete descriptions of all Civil 3D features.

The following is a list of the Civil 3D product documentation components that are automatically available when you install Civil 3D. These components are accessible from the product’s Help:

- Help system (User’s Guide)
- Tutorials
- Best Practices Guide
- New Features Workshop
- Moving from Land Desktop to Civil 3D (this guide)

Help System (User’s Guide)—The Civil 3D Help system is a compiled HTML Help system that provides comprehensive information about all Civil 3D features. The Help system is also known as the User’s Guide. It is available by pressing F1, or by clicking the Help button located in the InfoCenter toolbar. A PDF version of the entire Help system (User’s Guide), is available by clicking the User’s Guide in PDF link located in the Quick Links section of the Help landing page (right pane).

Online Tutorials—The tutorials offer an in-depth guided tour of the major features, using realistic engineering drawings and data. To gain a thorough knowledge of Civil 3D, it is recommended that you explore the tutorials after you have read through the conceptual information provided by the User’s Guide Help topics for a particular feature. A compiled Help version of the tutorials are available from the Help table of contents (left pane). A PDF version of the tutorials is available by clicking the link located on the Tutorials landing page (right pane).

Best Practices Guide—This guide presents best practices for implementing Civil 3D and using it efficiently in design operations. It is designed to help you optimize your use of Civil 3D. A compiled Help version of this guide is available from the Help table of contents (left pane). A PDF version of this
guide is available by clicking the link located on the Best Practices Guide landing page (right pane).

**New Features Workshop**—The New Features Workshop provides a graphical preview of features that are new with each version of the product. It includes descriptions of AutoCAD and Map 3D features in addition to new Civil 3D features. If you are moving from one version of the product to another, this is a useful tool for quickly understanding what’s new in the product. If everything is new to you, it is still a great way to get a quick overview of certain features. It is available by clicking New Features Workshop from the Help pull-down menu.

**Autodesk Training Programs and Products**

As you transition from Land Desktop to Civil 3D, you may want to invest in some level of formal Autodesk training. Autodesk training programs and products help you learn the key technical features of your Autodesk software quickly. For the latest information about Autodesk training, visit www.autodesk.com/training or contact your local Autodesk representative. The following sections describe the various Autodesk training programs and products that are available.

**Autodesk Authorized Training Centers**—To be more productive with Autodesk software, consider getting trained at an Autodesk Authorized Training Center (ATC®). These hands-on, instructor-led classes help you get the most from your Autodesk products. Enhance your productivity with proven training from over 1,400 ATC sites in more than 75 countries. For more information about Autodesk Authorized Training Centers, contact atc.program@autodesk.com or visit the online ATC locator at www.autodesk.com/atc.

**Autodesk Official Training Courseware**—Autodesk Official Training Courseware (AOTC) is technical training material developed by Autodesk. The modules are designed for 1/2-day to 5-day instructor-led classroom training. They are typically used by Authorized Training Centers and other Autodesk partners, but these materials are also well-suited for self-paced, stand-alone learning. The manuals cover key concepts and software functionality with hands-on, step-by-step, real-world exercises. You can purchase AOTC “Essentials” courseware from your local Autodesk representative or distributor, or you can order it online from the Training Tools section of the Autodesk Store at www.autodesk.com/store.

**e-Learning**—Autodesk e-Learning for Autodesk Subscription customers features interactive lessons organized into product catalogs. Each lesson is 20 to 40 minutes in length and features hands-on exercises, with an option to use either a simulation or the software application. You can also use an online
evaluation tool that identifies gaps in skills, determines which lessons will be most helpful, and gauges learning progress.

If you are a member of Autodesk Subscription, you can access e-Learning and other subscription services from within your Autodesk product. For more information about Autodesk subscription resources, visit www.autodesk.com/subscription.

**Autodesk Website**

A wealth of other resources are available from the Autodesk website. For example, you may want to check out the Civil Engineering Community portal, Skill Builder tutorials, or latest white papers, just to name a few. Also, a variety of useful items are frequently updated and posted on the Civil 3D website.

**Civil Engineering Community Portal**—Become a member of the Autodesk Civil Engineering Community to stay current with your industry, grow your professional network, and take advantage of a host of resources. Benefits of membership include access to Civil 3D content sharing, member discussions, blogs, local events, webcasts, and user-submitted tips and tricks. You are sure to hear from other Land Desktop users who have already moved or are in the process of moving to Civil 3D. To access the portal, visit www.autodesk.com/civilcommunity.

**Skill Builders**—Skill Builders are advanced learning exercises you use to practice performing specific design tasks using Civil 3D drawings. To download Civil 3D Skill Builders, visit www.autodesk.com/civil3d-skillbuilders.

**White Papers**—A variety of white papers on targeted industry-driven topics are available from the Civil 3D website. You can get in-depth technical information, competitive briefings, and valuable return on investment (ROI) analyses. To peruse and download Civil 3D white papers, visit www.autodesk.com/civil-whitepapers.

**Third-Party Resources**

You may also want to research third-party books and learning materials that are available from a variety of sources.
Comparing Land Desktop and Civil 3D

Maybe you knew how to do something in Land Desktop, but you need to find out how to perform the same function using Civil 3D. Where do you look in Civil 3D to find features that were familiar to you in Land Desktop? This chapter presents a variety of information that will help you quickly learn how to discover features and accomplish tasks in Civil 3D. It compares terminology, user interfaces, and some of the most commonly used features in both products.

Comparing Terminology

This section provides a list of terms that are common in the Land Desktop product and identifies the corresponding terminology that is used in the Civil 3D product.

For some features, the difference in terminology is subtle. For example, in Land Desktop a group of connected pipes is referred to as a pipe run, but in Civil 3D they are referred to as a pipe network.

For other features, the difference in terminology is quite distinct, indicating that there is more than just a difference in terminology. For example, in Land Desktop, you manage point groups using the Point Group Manager. In Civil 3D, you manage point groups using the Point Groups collection on the Prospector tab in Toolspace. Using the Toolspace Prospector is a completely different way of working with features that brings consistency across a number of features.

Reviewing the following tables will help you become familiar with terminology in Civil 3D. These tables may be handy references for you until your transition to Civil 3D is complete.
## General

The following table compares the differences in terminology between some general features in Land Desktop and the corresponding features in Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Preferences</td>
<td>Drawing template</td>
</tr>
<tr>
<td>Prototype Settings</td>
<td>Toolspace Settings tab</td>
</tr>
<tr>
<td>Drawing Settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quick Profile</td>
</tr>
<tr>
<td></td>
<td>3D Polyline commands</td>
</tr>
<tr>
<td></td>
<td>Feature Line tools</td>
</tr>
<tr>
<td></td>
<td>Reports/File Output</td>
</tr>
<tr>
<td></td>
<td>Report Manager</td>
</tr>
<tr>
<td></td>
<td>List values</td>
</tr>
<tr>
<td></td>
<td>Inquiry Tool or Inquiry toolbar</td>
</tr>
</tbody>
</table>

## Alignments

The following table compares the differences in terminology between alignment features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define From Objects</td>
<td>Create By Layout</td>
</tr>
<tr>
<td>Define From Polyline</td>
<td>Create From Object\Polyline</td>
</tr>
<tr>
<td>Alignment Labels</td>
<td>Alignment Label Styles</td>
</tr>
<tr>
<td>Station Labels</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Station</td>
</tr>
<tr>
<td></td>
<td>Station Offset</td>
</tr>
<tr>
<td></td>
<td>Line</td>
</tr>
<tr>
<td></td>
<td>Curve</td>
</tr>
<tr>
<td></td>
<td>Spiral</td>
</tr>
<tr>
<td></td>
<td>Tangent Intersection</td>
</tr>
<tr>
<td>Edit</td>
<td>Alignment Layout Toolbar</td>
</tr>
</tbody>
</table>
**Cross Sections (Road Design)**

The following table compares the differences in terminology between cross section (road design) features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw Template</td>
<td>Create Assembly</td>
</tr>
<tr>
<td></td>
<td>■ Subassemblies – From Catalog</td>
</tr>
<tr>
<td></td>
<td>■ Subassemblies – From Polyline</td>
</tr>
<tr>
<td>Design Control</td>
<td>Corridor Model Properties</td>
</tr>
<tr>
<td></td>
<td>■ Parameters</td>
</tr>
<tr>
<td></td>
<td>■ Targets</td>
</tr>
<tr>
<td></td>
<td>Assembly Properties</td>
</tr>
<tr>
<td>View/Edit Sections</td>
<td>View/Edit Corridor Section or Section Editor</td>
</tr>
<tr>
<td>Ditches/Transitions</td>
<td>Alignments/Profiles</td>
</tr>
<tr>
<td></td>
<td>Subassembly logic</td>
</tr>
<tr>
<td></td>
<td>Corridor Model Properties – Targets</td>
</tr>
<tr>
<td>Sample Existing Ground</td>
<td>Create Sample Lines</td>
</tr>
<tr>
<td>Section Plot Settings</td>
<td>Sample Line Group Properties</td>
</tr>
<tr>
<td>Section Plot</td>
<td>Create Views (Section)</td>
</tr>
<tr>
<td></td>
<td>■ Single</td>
</tr>
<tr>
<td></td>
<td>■ Multiple</td>
</tr>
<tr>
<td>List Section Data</td>
<td>Inquiry Tool ➤ Section View</td>
</tr>
<tr>
<td></td>
<td>Inquiry Tool ➤ Section</td>
</tr>
<tr>
<td>Label Sections</td>
<td>Section Label Styles</td>
</tr>
<tr>
<td></td>
<td>Section View Styles</td>
</tr>
<tr>
<td></td>
<td>Section View Band Styles</td>
</tr>
<tr>
<td></td>
<td>Section View Labels</td>
</tr>
<tr>
<td>Total Volume Output</td>
<td>Quantity Takeoffs</td>
</tr>
</tbody>
</table>
The following table compares the differences in terminology between grading features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface Volume Output</td>
<td>Composite Volumes Panorama utility</td>
</tr>
<tr>
<td></td>
<td>Volume Surface</td>
</tr>
<tr>
<td>Road Output</td>
<td>Corridor Model Surface</td>
</tr>
</tbody>
</table>

**Grading**

**Inquiry**

The following table compares the differences in terminology between inquiry features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grading Wizard</td>
<td>Grading Creation Tools</td>
</tr>
<tr>
<td>Footprint</td>
<td>Feature Line</td>
</tr>
<tr>
<td>Targets and Slopes, Daylighting</td>
<td>Grading Criteria</td>
</tr>
<tr>
<td>Appearance</td>
<td>Grading Style</td>
</tr>
<tr>
<td>Grading Properties</td>
<td>Grading Editor</td>
</tr>
<tr>
<td>Create Surface</td>
<td>Grading Properties</td>
</tr>
<tr>
<td>Calculate Volume, Balance Volume</td>
<td>Automatic Surface Creation</td>
</tr>
<tr>
<td></td>
<td>(Grading Group property)</td>
</tr>
<tr>
<td></td>
<td>Grading Volume Tools</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>North/East</td>
<td>Inquiry Tool ➤ Point ➤ Point Inverse</td>
</tr>
<tr>
<td>Lat/Long</td>
<td></td>
</tr>
<tr>
<td>Geodetic Inverse</td>
<td></td>
</tr>
<tr>
<td>Land Desktop</td>
<td>Civil 3D</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Station Offset – Alignment</td>
<td>Inquiry Tool ➤ Alignment ➤ Alignment Station and Offset at Point</td>
</tr>
<tr>
<td>Line/Curve/Spiral</td>
<td>Object Properties</td>
</tr>
<tr>
<td>Roadway Curves</td>
<td>Alignment Layout Toolbar ➤ Sub-Entity Editor ➤ Alignment Grid View</td>
</tr>
<tr>
<td>Railway Curves</td>
<td></td>
</tr>
<tr>
<td>Spiral Radius</td>
<td></td>
</tr>
<tr>
<td>Angles</td>
<td>Analyze tab ➤ Inquiry panel ➤ Angle Information</td>
</tr>
<tr>
<td>Distance</td>
<td>Analyze tab ➤ Inquiry panel ➤ Continuous Distance</td>
</tr>
<tr>
<td></td>
<td>Analyze tab ➤ Inquiry panel ➤ Add Distance</td>
</tr>
<tr>
<td></td>
<td>Analyze tab ➤ Inquiry panel ➤ Distance</td>
</tr>
<tr>
<td>Area by Lines/Curves, Polylines, or Points</td>
<td>Analyze tab ➤ Inquiry panel ➤ Area</td>
</tr>
<tr>
<td></td>
<td>Analyze tab ➤ Inquiry panel ➤ Line and Arc Information</td>
</tr>
<tr>
<td></td>
<td>Analyze tab ➤ Inquiry panel ➤ Locate Point</td>
</tr>
<tr>
<td>Contour/Surface Elevation</td>
<td>Inquiry Tool ➤ Surface</td>
</tr>
<tr>
<td>List Slope/Elevation at Slope</td>
<td>Inquiry Tool ➤ Surface</td>
</tr>
<tr>
<td></td>
<td>Analyze tab ➤ Inquiry panel ➤ List Slope</td>
</tr>
<tr>
<td>Track North/East, Track Elevation</td>
<td>Coordinate Tracker</td>
</tr>
</tbody>
</table>
### Parcels

The following table compares the differences in terminology between parcel features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parcel Settings</td>
<td>Parcel Layout Tools Toolbar</td>
</tr>
<tr>
<td></td>
<td>Parcel Styles</td>
</tr>
<tr>
<td></td>
<td>Parcel Label Styles</td>
</tr>
<tr>
<td>Parcel Manager</td>
<td>List View on the Toolspace Prospector tab</td>
</tr>
<tr>
<td></td>
<td>Parcel Properties</td>
</tr>
<tr>
<td>Define from Lines/Curves (or Polylines)</td>
<td>Create From Objects</td>
</tr>
<tr>
<td>Define from Points</td>
<td>Parcel Layout Tools Toolbar</td>
</tr>
<tr>
<td></td>
<td>Transparent Commands</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Points</td>
</tr>
<tr>
<td></td>
<td>Slide Bearing</td>
</tr>
<tr>
<td></td>
<td>Radial</td>
</tr>
<tr>
<td></td>
<td>Swing Line</td>
</tr>
<tr>
<td></td>
<td>Swing On Curve</td>
</tr>
</tbody>
</table>

### Pipes

The following table compares the differences in terminology between pipe features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Pipe Command Settings</td>
</tr>
<tr>
<td></td>
<td>Parts List</td>
</tr>
<tr>
<td>Pipe Run</td>
<td>Pipe Network</td>
</tr>
<tr>
<td>Pipe</td>
<td>Pipe</td>
</tr>
<tr>
<td>Node</td>
<td>Structure</td>
</tr>
<tr>
<td>Pipe Run Editor</td>
<td>List View in Toolspace (Panorama) View</td>
</tr>
<tr>
<td>Land Desktop</td>
<td>Civil 3D</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Edit Graphical</td>
<td>Grip edit</td>
</tr>
<tr>
<td>Edit Data</td>
<td>Pipe Editor</td>
</tr>
<tr>
<td></td>
<td>Structure Editor</td>
</tr>
<tr>
<td>Finish Draft Plan</td>
<td>Create Pipe Network</td>
</tr>
<tr>
<td>Finish Draft Profile</td>
<td>Draw Parts in Profile View</td>
</tr>
<tr>
<td>Finish Draft Section</td>
<td>Sample Pipe Network (Sample Line Group)</td>
</tr>
<tr>
<td>Import/Export Runs</td>
<td>Import LandXML</td>
</tr>
<tr>
<td></td>
<td>Export LandXML</td>
</tr>
<tr>
<td>Align/Run Interferences</td>
<td>Create Interference Check</td>
</tr>
</tbody>
</table>

**Plan Production**

The following table compares the differences in terminology between plan production features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet Creation</td>
<td>Plan Production Tools ➤ Create Sheets wizard</td>
</tr>
<tr>
<td>Sheet Manager</td>
<td>Plan Production Tools ➤ Create Sheets wizard</td>
</tr>
<tr>
<td>Sheet Set Manager</td>
<td>Sheet Set Manager</td>
</tr>
<tr>
<td>Sheet Series</td>
<td>View Frame Group</td>
</tr>
<tr>
<td>Frame</td>
<td>View Frame</td>
</tr>
<tr>
<td>Create&gt;Edit Frame</td>
<td>Create View Frames wizard, Edit View Frames</td>
</tr>
<tr>
<td>Match Line</td>
<td>Match Line</td>
</tr>
</tbody>
</table>
Points

The following table compares the differences in terminology between point features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Sheets</td>
<td>Create Sheets (Create Sheets wizard)</td>
</tr>
<tr>
<td>Point Settings</td>
<td>Toolspace Settings tab, Point Command Settings</td>
</tr>
<tr>
<td>Point Group Manager</td>
<td>Toolspace Prospector tab, Point Groups collection</td>
</tr>
<tr>
<td>XDRef Manager</td>
<td>Toolspace Settings tab ➤ Point ➤ External Data References</td>
</tr>
<tr>
<td>Create Points (all commands)</td>
<td>Create Points</td>
</tr>
<tr>
<td>List Points</td>
<td>Toolspace Prospector tab ➤ List View Panorama Point Editor</td>
</tr>
</tbody>
</table>

Profiles

The following table compares the differences in terminology between profile features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile (grid only)</td>
<td>Profile View</td>
</tr>
<tr>
<td>Vertical Alignment, Existing Grade</td>
<td>Profile</td>
</tr>
<tr>
<td>Profile Settings</td>
<td>Profile Command Settings</td>
</tr>
<tr>
<td>Set Current Surface</td>
<td>Create Profile From Surface dialog box</td>
</tr>
<tr>
<td>Toggle Multiple Surfaces</td>
<td></td>
</tr>
<tr>
<td>Select Multiple Surfaces</td>
<td></td>
</tr>
</tbody>
</table>
## Survey

The following table compares the differences in terminology between survey features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Existing Ground – Sample from</td>
<td>Create Profile From Surface dialog box</td>
</tr>
<tr>
<td>Surface</td>
<td></td>
</tr>
<tr>
<td>Sample Existing Ground – Sample from</td>
<td>Create Profile From Surface dialog box</td>
</tr>
<tr>
<td>File</td>
<td></td>
</tr>
<tr>
<td>Create Full or Surface Profile</td>
<td>Create Profile From Surface</td>
</tr>
<tr>
<td>Create Profile</td>
<td>Create View</td>
</tr>
<tr>
<td>■ Grid</td>
<td></td>
</tr>
<tr>
<td>Create Profile</td>
<td>Quick Profile</td>
</tr>
<tr>
<td>■ Quick Profile</td>
<td></td>
</tr>
<tr>
<td>Define Vertical, Ditch, and Transition</td>
<td>Create By Layout (Profile Layout Toolbar)</td>
</tr>
<tr>
<td>Alignments</td>
<td></td>
</tr>
<tr>
<td>Edit Vertical, Ditch, and Transition</td>
<td>Edit Profile Geometry (Profile Layout Toolbar)</td>
</tr>
<tr>
<td>Alignments</td>
<td></td>
</tr>
</tbody>
</table>

### Survey

The following table compares the differences in terminology between survey features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th>Land Desktop</th>
<th>Civil 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Collection Input</td>
<td>Survey tab in Toolspace</td>
</tr>
<tr>
<td>Analysis Figures</td>
<td>Survey tab in Toolspace</td>
</tr>
<tr>
<td>Least Square Settings</td>
<td>Survey Database Settings</td>
</tr>
<tr>
<td>Survey Command Line</td>
<td>Survey Command Window</td>
</tr>
<tr>
<td>Equipment Settings</td>
<td>Equipment Databases and Equipment Properties</td>
</tr>
</tbody>
</table>
The following table compares the differences in terminology between terrain (or surfaces) features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th><strong>Land Desktop</strong></th>
<th><strong>Civil 3D</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure Prefix Library</td>
<td>Figure Prefix Databases and Figure Prefix Properties</td>
</tr>
<tr>
<td>Astronomic Azimuth</td>
<td>Astronomic Direction Calculator</td>
</tr>
</tbody>
</table>

**Terrain (Surfaces)**

The following table compares the differences in terminology between terrain (or surfaces) features in Land Desktop and Civil 3D:

<table>
<thead>
<tr>
<th><strong>Land Desktop</strong></th>
<th><strong>Civil 3D</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Terrain</td>
<td>Surfaces</td>
</tr>
<tr>
<td>Terrain Model Explorer</td>
<td>Toolspace Prospector tab ➤ Surfaces collection</td>
</tr>
<tr>
<td>Edit Surface</td>
<td>Surfaces ➤ Edit Surface</td>
</tr>
<tr>
<td>Surface Display</td>
<td>Surface Style</td>
</tr>
<tr>
<td>Contour Style Manager</td>
<td>Surface Style ➤ Contours tab</td>
</tr>
<tr>
<td>Contour Labels</td>
<td>Surfaces ➤ Add Surface Labels</td>
</tr>
<tr>
<td>Composite Volumes</td>
<td>Composite Volumes Panorama utility</td>
</tr>
<tr>
<td></td>
<td>Volume Surface, TIN Volume Surface</td>
</tr>
</tbody>
</table>

**Utilities**

The following table compares the differences in terminology between features related to various utilities in Land Desktop and the corresponding features in Civil 3D:

<table>
<thead>
<tr>
<th><strong>Land Desktop</strong></th>
<th><strong>Civil 3D</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Viewer</td>
<td>Object Viewer</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes</td>
</tr>
</tbody>
</table>
Comparing User Interfaces

This section compares the Land Desktop and Civil 3D user interfaces. It provides an overview of the general differences in the user interfaces, and includes sections that discuss the ribbon, menu bars, toolspace, and workspaces.

User Interfaces

Many aspects of the Land Desktop and Civil 3D user interfaces are identical. For example, since both products are based on industry-leading AutoCAD software, Civil 3D still provides you with the familiar graphical work environment and drafting tools you already know from using Land Desktop. In Civil 3D, you’ll notice components like the menu bar, command line, drawing area, and model and layout tabs you already know how to use. The drawing status bar and application status bar that display at the bottom of the application window are also similar.

Some other user interface components though are quite different. The following sections compare and describe these differences.
The Ribbon

One of the most noticeable differences between the Land Desktop and Civil 3D user interfaces is the ribbon in Civil 3D.

The ribbon is a palette that displays task-based commands and controls. The ribbon provides access to nearly all of the features available in the product, and is designed to serve as the primary mechanism for accessing functionality.

Becoming familiar with using the ribbon is probably one of the most significant tasks you can master as you transition from using Land Desktop to using Civil 3D. Luckily, there are a variety of resources available in Civil 3D to help you learn how to use it. See Learning to Use the Ribbon Learning to Use the Ribbon in the Civil 3D Help for more information.

The Civil 3D menu bar is still available. However, it is important to note that the menu bar in Civil 3D is turned off by default, and is really the Civil 3D 2009 (legacy) menu bar. As such, new features that have been added to Civil 3D are not available from the menu bar. Instead, they are only available from the ribbon. Therefore, if you want to ensure that you have access to all of the functionality available in Civil 3D, you will need to use the ribbon.

Menu Bars

The Civil 3D menu bar is similar in many ways to the Land Desktop menu bar. For example, the Land Desktop menu bar that is displayed when the Land Desktop Complete workspace is current contains the following top-level items:

- File
- Edit
- View
- Insert
- Format
- Tools
- Draw
- Dimension
- Modify
- Map
- Express
- Projects
- Points
- Lines/Curves
- Alignments
- Parcels
- Labels
- Terrain
- Inquiry
- Utilities
- Window
- Help.

In the above list, items that are bolded are also available on the Civil 3D menu bar when the default Civil 3D workspace is current. As you will see, many components exist in both products.
Because Civil 3D uses the ribbon as its primary user interface, the menu bar is turned off by default. However, you can turn it on by setting the menubar variable to 1 at the command line.

**Toolspace**

Another significant and noticeable difference between the Land Desktop and Civil 3D user interfaces is the Civil 3D Toolspace window—a component that Land Desktop does not have.

The Toolspace window is a concept that is totally new to Land Desktop users. Using the three Toolspace window tabs, the Prospector, Settings, and Survey tabs, you can control drawing objects and settings in ways that are not possible with Land Desktop.

For example, using the Prospector tab, you can quickly display a hierarchical list of all objects in your drawing. Items that exist as child objects to a parent object, such as pipe and structure objects associated with a pipe network (pipe run), can easily be displayed in the Prospector tab.

The Settings tab provides a powerful set of features for creating and managing object styles, as well as for controlling default object behavior.
Becoming familiar with how to use the Civil 3D Toolspace window is an important step to Civil 3D proficiency. Once you understand how it works, it’s very easy to use, and it will provide many ways to increase your productivity. To learn more about how to use the Civil 3D Toolspace, see The Toolspace Window in the Civil 3D Help.

Workspaces

Just like Land Desktop, Civil 3D comes equipped with a variety of workspaces that offer sets of tools commonly used for certain types of tasks. For example, in Land Desktop you can select the Survey workspace which provides access to tools and features commonly used while performing surveying tasks.

With both products, you can create your own custom workspaces so that you can have quick access to a specific set of features you may want. In addition to displaying a menu bar that contains only the features related to a specific task, the workspaces automatically display toolbars, tool palettes, and other user interface elements to make sure that all the features you need for a specific task are at your fingertips. The Custom User Interface dialog box, available in both Land Desktop and Civil 3D, lets you view and edit the items that are available through the various workspaces.

One important item to note regarding workspaces, is that with Civil 3D, because you have the ribbon, you can customize the items available on the
ribbon tabs, and make them available through workspaces. Since Land Desktop does not have the ribbon, you do not have this capability.

The following table lists the menus that are displayed in the menu bar for the workspaces that come with Land Desktop 2009:

<table>
<thead>
<tr>
<th>Land Desktop Workspaces</th>
<th>Land Desktop Menus</th>
</tr>
</thead>
</table>

The following table lists the menus that are displayed in the menu bar for the Civil 3D workspaces:

<table>
<thead>
<tr>
<th>Civil 3D Workspaces</th>
<th>Civil 3D Menus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Civil 3D</td>
<td>File, Edit, View, Insert, General, Survey, Points, Surfaces, Lines/Curves, Parcels, Grading, Alignments, Profiles, Corridors, Sections, Pipes, Annotation, Inquiry, Window, Express.</td>
</tr>
<tr>
<td>2D Drafting &amp; Annotation</td>
<td>File, Edit, View, Insert, Format, Tools, Draw, Dimension, Modify, Parametric, Window, Help, Express.</td>
</tr>
</tbody>
</table>
Civil 3D Workspaces | Civil 3D Menus
--- | ---
Tool-based Geospatial | This workspace provides access to Map 3D functionality. It contains the following Map 3D items available from the menu bar: File, Edit, View, Create, Modify, Analyze, Setup, Window, Help, Express.
Task-based Geospatial | This workspace provides access to Map 3D functionality. It contains the following Map 3D items available from the menu bar: File, Edit, View, Create, Modify, Analyze, Setup, Window, Help, Express.

To become more familiar with workspaces, including how to access them, edit them, and create your own custom workspaces, refer to Create Task-Based Workspaces in the AutoCAD Help.

**Civil 3D Lines and Curves Features**

Civil 3D has lines and curves features that are modeled after the Land Desktop Lines/Curves menu; however, Civil 3D has a few additional features.

For example, in Civil 3D you access the lines and curves features from the Draw panel on the ribbon Home tab. Click the Line button to display a drop-down menu of lines commands. These are nearly identical to the lines commands available in Land Desktop.
The Civil 3D curves commands are also available from a pull-down menu on the ribbon, and the curve commands are nearly identical to those in Land Desktop.
In Civil 3D, you also have the Curve Calculator (Home tab ➤ Draw panel ➤ Curve Calculator), which is a tool you use to determine curve parameters based on input. It lets you calculate horizontal curve data and simultaneously interact with active Civil 3D COGO commands as well as AutoCAD commands.

With this functionality, you can calculate horizontal curve properties based on arc or chord definitions. You can select an arc object from the drawing and display its curve properties in the Curve Calculator. Also, you can calculate properties and send a curve property to the command line interface within a current command, or send the properties to the Windows Clipboard to cut-and-paste into another application.

**Comparing Features**

This section explores a few of the more commonly used features that exist in both Land Desktop and Civil 3D. It discusses the differences in methodologies and workflows inherent in these features in both products. Understanding the mechanics of how the features are different (for example, understanding what the Civil 3D software is doing behind the scenes, what the user interfaces look like, and what a typical Civil 3D workflow is like) will greatly reduce the learning curve.

In this section, we’ll compare how the following features work in Land Desktop and in Civil 3D: points, surfaces, alignments and profiles. An important item to note as you read through this section is that many of the Civil 3D concepts and behaviors you’ll learn about exist in many areas of the product. This section also illustrates how Civil 3D is much more consistent than Land Desktop in the way that it allows you to manage features.
Points

Experienced Land Desktop users will be happy to know that Civil 3D combines several of the point functionality concepts from Land Desktop into an easy-to-use Civil 3D point object. This section begins with a brief description of how points work in Land Desktop.

Points in Land Desktop

The Land Desktop point concepts you are already familiar with include point settings, point object, point symbology, point groups, and point labeling. The following table provides a brief description of how each of these concepts is implemented in Land Desktop:

<table>
<thead>
<tr>
<th>Land Desktop Point Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point Settings</td>
<td>When creating points in Land Desktop, first you need to adjust Point Settings to achieve desired output. These settings control things like the starting Point Number, whether elevations are required, if descriptions are visible, where to find symbology, text size, and so on. All points created after these Point Settings are established adopt the current Point Settings and are displayed accordingly. Points created before the Point Settings are either established or changed would remain as they are.</td>
</tr>
<tr>
<td>Point Object</td>
<td>Each point in Land Desktop is an individual object and is part of an external points database file (*.mdb).</td>
</tr>
<tr>
<td>Point Symbology</td>
<td>For a point to represent something like a fire hydrant, description keys can be used to automatically insert a symbol (block) at the point’s insertion point.</td>
</tr>
<tr>
<td>Point Labeling</td>
<td>Point labels, usually combined with Point Groups, let you quickly show point descriptions on some points and not others, label data, such as northing and easting, and</td>
</tr>
</tbody>
</table>
Even though point functionality in Land Desktop accomplishes the work you need to do, and you are comfortable with it, it still has some limitations. For example:

- Have you ever moved some points only to realize that your symbols did not move with them?
- Have you ever wished you could use the Undo command after accidentally moving or erasing some points?
- Have you ever wished there was a way to quickly change point sizes, with just a few clicks, so they could be used in a 50 scale drawing instead of a 100 scale drawing?
- Have you ever wanted to create a Point Group by combining several other Point Groups?
- Have you ever found it difficult to maintain standards so that points labeled by one individual on your team look the same as points labeled by someone else?

### Points in Civil 3D

When you are working with points in Civil 3D, one of the first things that is important to understand is that in Civil 3D, each point is maintained as an individual object. Each point also always belongs to a point group, which is also an object. This means that you can manage points at different hierarchical levels. Being able to manage points this way improves overall performance and provides additional flexibility that you do not have when using points in Land Desktop.

A second concept that is important to understand is that unlike Land Desktop points, the display characteristics of Civil 3D points are based on two style settings: the point style and the point label style. This is a concept that is employed throughout many Civil 3D object types.
The point marker (shown as the “X” in the preceding illustration) is controlled by the point style and the label text for the point is controlled by the point label style. Setting up proper styles is one of the keys to unlocking the potential of Civil 3D. By simply setting the point style to the desired marker, which can include symbology, and setting the point label style to the desired label style, you can achieve virtually limitless combinations for displaying points.

Note that in Civil 3D, when you are using symbology as part of your point style, the symbol is the marker. In other words, there is no separate block inserted on top of the point. Instead, the symbol is embedded in the point itself. Because points are dynamic in Civil 3D, so are the symbols. For example, there is no need to maintain multiple fire hydrant blocks to accommodate plotting drawings at multiple scales. Also, symbols never become separated from their associated points as they may have in Land Desktop. Your point styles can be set in such a way that you can still control visibility of the symbology, and the points still do what they did in Land Desktop. For example, you can still show symbols and no points, or show points and no symbols, or show neither. It is simply easier to do this in Civil 3D.

Civil 3D contains numerous styles you can begin working with right away, including ones that look like Land Desktop styles. These styles can be assigned to the points directly by selecting the point(s), and then right-clicking and clicking Edit Points. Doing it this way is like switching from a BYLAYER setting to a fixed setting.

You can also set these styles at the point group level, which means that all points in that group are updated automatically. To do this, simply click on the desired Point Group in the Project Toolspace (Prospector Tab), right-click, and click Properties.
Because you can associate a symbol with your points using the point style, does this mean that description keys are not necessary in Civil 3D? This is your decision. Description keys still exist and still function in Civil 3D similar to how they function in Land Desktop. The major difference is that instead of inserting blocks, as you would in Land Desktop, in Civil 3D, you set the desired point style and point label style for each point. With Civil 3D, you can decide which method of handling point styles and symbology works best for your situation.

A third concept to understand when comparing Civil 3D and Land Desktop point functionality is the fact that Civil 3D project data is drawing based rather than project based as in Land Desktop. Because Civil 3D data is drawing based, the points exist in your drawing file and do not point to an external point.
database, as they do in Land Desktop. This means that your points cannot become out of sync with an external point database, so operations such as the Undo command are no longer a problem. Without an external point database, commands like Check Points and Insert Points To Drawing are no longer necessary, as well.

Creating Points

The way that you create points in Civil 3D is very similar to how you created points in Land Desktop. For example, you can use the CreatePoints command or the individual commands from the Points drop-down menu on the ribbon’s Home tab. When you click Point Creation Tools on the Points drop-down menu, the Create Points toolbar is displayed.

![Create Points toolbar](image)

Under each button on the toolbar are various drop-down options for creating points. These options should look familiar to Land Desktop users because most of the methods are the same as in Land Desktop. Even the Import Points dialog box in Civil 3D, shown in the following illustration, should look familiar.
So while some aspects of using points are very different in Civil 3D, much of your Land Desktop knowledge is still directly transferable when you start using Civil 3D.

**Editing Points**

Editing points in Civil 3D is also not that different from how you did it in Land Desktop. For example, the following illustration shows the similarities between the editing points in Civil 3D and Land Desktop.

The following illustration shows the Land Desktop Edit Points drop-down menu:
The following illustration shows the Civil 3D edit point commands that are available from the COGO Point contextual tab on the ribbon:

You can access many more features than were available from the Land Desktop Edit Points menu.

It is also important to note that in the Land Desktop menu, many of the Edit options are necessary due to the fact that the point database in Land Desktop is actually external to Land Desktop. Therefore, many of these special Point Edit commands are completely unnecessary in Civil 3D. In other words, rather than having a special Rotate Points or Erase Points command, in Civil 3D you can use standard AutoCAD commands to do many of your edits.

**Point Groups**

As soon as you create your first point in Civil 3D, an “All Points” group is automatically created. All points in your drawing are contained in the All Points group. As in Land Desktop, you can create as many additional groups as you need.

While you are examining Civil 3D, note the Point Groups tab at the top of the Point Group Properties dialog box. This tab lets you create a point group using other point groups. For example, if you have a “Road CL Group”, a “Road EOP Group”, and a “Road Curb Group”, you can create a new “Roadway Group” using the other Road Groups. Perhaps you have a “Wednesday Group” a “Thursday Group” and a “Friday Group” that contain points to be staked.
on each day. You could create an overall “Stake Out Group” containing the other three groups without having to spend more time trying to filter out points from Wednesday, Thursday, and Friday.

**Summary**

Now that you’ve explored the differences between points in Land Desktop and Civil 3D, let’s review how Civil 3D can provide you with a better solution for working with points:

<table>
<thead>
<tr>
<th>Land Desktop Limitation</th>
<th>Civil 3D Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you ever moved some points only to realize your symbols didn’t move with them?</td>
<td>In Civil 3D, the symbol is part of the point itself.</td>
</tr>
<tr>
<td>Have you ever wished you could use the Undo command after accidentally moving or erasing some points?</td>
<td>Civil 3D does not rely on an external point database, so you can use the Undo command during point operations.</td>
</tr>
<tr>
<td>Have you ever wished there was a fast way to change your point sizes so they could be used in a 50 scale drawing rather than a 100 scale drawing?</td>
<td>Because Civil 3D points are dynamic, they will automatically adjust their size by simply changing the drawing scale.</td>
</tr>
<tr>
<td>Have you ever wanted to create a point group by combining several other point groups?</td>
<td>Civil 3D point groups can be created from other point groups.</td>
</tr>
<tr>
<td>Have you ever found it difficult to maintain your organization’s CAD standards so that points labeled by one person look the same as points labeled by another person?</td>
<td>Civil 3D uses templates with built-in styles to guarantee standards compliance.</td>
</tr>
</tbody>
</table>

**Surfaces**

When you work with surfaces in Civil 3D, you will notice many differences from Land Desktop right away. What is important to understand is that all of the same functionality you had with surfaces in Land Desktop still exists in Civil 3D. The functionality is just simplified, and in some cases, uses a different methodology to accomplish the same result. The following section provides a brief description of how surfaces work in Land Desktop.
**Surfaces in Land Desktop**

The Land Desktop concepts and tools that are built into the Civil 3D surface object include the Terrain Model Explorer, Surface Editing, Contour Creation, and the Contour Object. The following table briefly summarizes how these features work in Land Desktop:

<table>
<thead>
<tr>
<th>Land Desktop Surface Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terrain Model Explorer</td>
<td>You create surfaces in Land Desktop using the Terrain Model Explorer where you can select data from sources such as point groups or boundaries to build a surface. Once built, the surface is written to an external file, which is actually a folder of data under the Land Desktop Project/DTM folder. Having the surface connected to this external file presents several of the same issues you might have with points.</td>
</tr>
<tr>
<td>Surface Editing</td>
<td>If you want to edit your newly created surface, you must first import 3D lines. This is because the surface exists in an external file, and not in the drawing. After importing the 3D lines, there are numerous options available for performing edits. For example, if you want to “flip face”, you must do it one at a time. Furthermore, after each flip, you must rebuild the surface, reimport the contours, and possibly, re-label all the contours. This type of workflow can result in designers having to perform these tasks over and over again.</td>
</tr>
<tr>
<td>Contour Creation</td>
<td>After you finish editing a surface, you must create contours using yet another tool.</td>
</tr>
<tr>
<td>Contour Object</td>
<td>Each contour is a separate object with no association back to the original surface. Editing the surface means you must recreate contours.</td>
</tr>
</tbody>
</table>
Building surfaces in Land Desktop involves many steps, and the process is not very intuitive. Although the process lets you accomplish the work you need to do, it does have several limitations. For example:

- Have you ever created a surface and wished there was some immediate visual feedback to show what you created?
- Have you ever edited a surface and wished your contours would update automatically?
- Have you ever wished you could use the standard Undo command to fix a mistake you made to your surface?
- Have you ever had to extensively edit a surface created from contours to correct areas not interpolated correctly?
- Have you ever wished your contour labels could faithfully be used for multiple scale drawings?

**Surfaces in Civil 3D**

In Civil 3D, you can create surfaces on the Prospector Tab in the Toolspace window by right-clicking on the Surfaces collection, and clicking Create Surface. Or you can also select the same command from the ribbon (Home tab ➤ Create Ground Data Panel ➤ Surfaces drop-down ➤ Create Surface). A dialog box prompts you to assign the surface a name and a style. If you don’t assign the surface a name, it is given a default name which is typically Surface[1]. This default object naming is just one of the useful conventions used in many Civil 3D features.
After supplying a name for the surface and clicking OK, the new surface object is displayed in the Prospector tree. Similar to the Land Desktop Terrain Model Explorer, you can expand the + symbol next to the newly created surface to view the items beneath it and assign the data you want to use to build the surface. You’ll notice that the list of available data types contains primarily the same types that are available in Land Desktop.
By right-clicking on a data type (such as Contours, for example) and adding the necessary data, the surface is automatically built and displayed in model space according to the style settings.

The process of building a surface from contour data in Civil 3D produces far superior results than what can be created with Land Desktop. For example, in Civil 3D, if you display contours on a newly created surface that was created from contour data, the contours will match the original. This is a significant improvement over the surface capabilities in Land Desktop.

Another aspect of Civil 3D surfaces that is important to understand is the surface style. In Civil 3D, the surface is the object, and the contours are subsets of that object. This is another area where the capabilities of Civil 3D far exceed Land Desktop. Because the contours are a subset of the surface, by simply changing the surface style you can present the surface in a wide variety of ways. For example, you can show contours at different intervals, with slope arrows, elevation banding, and more. Showing contours at 1’ and 5’ intervals after they were originally displayed at 2’ and 10’ intervals is as simple as a few clicks. The same is true for displaying components like elevation banding. Performing a similar task in Land Desktop would take many minutes as opposed to just a few seconds in Civil 3D. To display a particular subset of the surface, you need only turn it on in the Display tab for the surface style. To
configure a specific subset like contours, simply click on the appropriate tab and set the values as desired.

![Surface Style - Contours](image)

Civil 3D includes drawing templates that contain numerous predefined surface styles you can choose from or use as a starting point for creating your own.

**Surface Editing**

To edit a surface, you can set up the surface style to display both triangles and points. You might even want to consider creating a style specifically for editing.

In Civil 3D, all Surface Edit functions are conveniently located from the Surfaces collection in the Prospector tree, by right-clicking on the surface object in the drawing or in the Prospector tree, or from the Surface tab on the ribbon. The options available should look familiar to Land Desktop users. If you compare the Land Desktop Edit Surface drop-down menu to the Civil 3D Edit Surface commands available from the Surface tab in the ribbon, with the exception of Flip Face being renamed to Swap Edge—you’ll notice that many of the features are virtually identical.

The following illustration shows the Land Desktop Edit Surfaces drop-down menu:
The following illustration shows the Civil 3D Edit Surface commands available from the Surface tab on the ribbon:
The following illustration shows more surface commands that are available from the Civil 3D Surface tab on the ribbon:

To launch surface creation commands, use the choices on the Surfaces pull-down menu available from the Create Ground Data panel on the Home tab.
Because a Civil 3D surface is not connected to an external data file, many steps that were required in Land Desktop become unnecessary, such as using commands like Import 3D Lines, Create Contours, Build Surface, and Quick View. Also, other commands become a lot simpler to use—for example, Undo, Redo, Move, and Rotate. Have you ever wished that you could simply Undo an errant surface edit? With Civil 3D, you can.

Because the surface object is the only representation of the surface data, you no longer have to worry about whether the surface displayed in your drawing actually matches the surface in your data file. For example, with Land Desktop, you sometimes had to worry that someone might modify the contours displayed on the screen, and as a result, the surface might not match the surface file currently being staked in the field. By maintaining a single surface object, the process of creating and editing a surface is simpler, and the chances of errors are reduced.

Like Civil 3D points, surfaces can also be dynamic. By simply modifying the underlying data used to create the surface, the surface is updated automatically. For example, in Civil 3D, if you move a point or grip edit a boundary, the surface is updated. Unlike the static methodology used in Land Desktop, using the dynamic model-based design in Civil 3D, you can automatically roll forward any changes made to your data.

**Labeling Contours**

Labeling contours in Civil 3D is similar to labeling contours in Land Desktop. Actually, the process is similar but the end result is different. Basically you
drape a Contour Label Line across multiple contours. This is the same as using Label Group Interior in Land Desktop. Everywhere a contour intersects the Contour Label Line, a contour label appears. The contour labels themselves remain on the Contour Label Line and not on the contour itself. If you drag the label line to different locations, the labels move with it. If you alter contour intervals, for example, and if the new contours intersect the label line, they are automatically labeled. This new contour behavior in Civil 3D may take some practice to get used to, but the time savings of being able to make minor to extensive changes to your surface without having to constantly re-label the contours is substantial. You access the contour labeling features either by clicking on a surface in the drawing, or by clicking Surfaces on the Modify tab. Either of these methods displays the Surfaces tab on the ribbon. On the Labels and Tables panel of the Surfaces tab, click the drop-down arrow next to Add Labels to display the list of contour labeling commands. Select Contour - Single, Contour - Multiple, or Contour - Multiple At Interval.

After selecting a contour labeling command, you are prompted to pick two points in model space. The line defined by these points becomes your Contour Label Line. Like everything else in Civil 3D, contour labels are controlled by styles. By modifying these styles, you can adjust the label look-and-feel to match your particular organization’s requirements.

**Calculating Earthwork**

In Land Desktop, the process of calculating earthwork is complicated to say the least. For example, as a minimum it can involve creating a stratum, defining a site, having to understand the difference between grid, section, and composite, and so on. Furthermore, many designers find that they do not perform earthwork functions very frequently, which can make the task even more difficult. Fortunately, Civil 3D makes the process of calculating earthwork simple.

All you need are two surfaces and you can begin the process of calculating earthwork by clicking Surfaces on the Modify tab. Alternatively, you can also just click on a surface in the drawing. Either of these methods displays the Surfaces tab on the ribbon. On the Analyze panel of the Surfaces tab, click Volumes.

The Panorama is displayed. You first create a new volume entry in the list by clicking the Create New Volume Entry icon (upper left corner of the Panorama window). Then click in the cell under Base Surface and select the starting surface, select a surface in the cell under Comparison Surface to select your finishing surface. In a few seconds, Civil 3D performs a composite calculation between the two surfaces and displays the result.
You can still perform an earthwork calculation using multiple methods, as in Land Desktop. The two possible methods are Grid and Composite. You can perform these types of calculations just as easily in Civil 3D as in Land Desktop. It is no more difficult than creating a new Volume surface. These types of surfaces (Grid Volume Surface and TIN Volume Surface) are created using the same tool as a regular surface. Rather than specifying components like Point Group and Contour Data as data types to build the surface, you need only select two surfaces to compare.

As a result of performing a calculation this way, you have the added benefit of creating a surface that can be used to display cut and fill contours or elevation banding to validate earthwork numbers.

The following illustration shows an example of a surface style being used to display earthwork cut and fill data by using elevation banding. Colors can be used to indicate cut and fill areas. For example, a color such as dark red could be used to indicate deepest cut, and dark blue could be used to indicate highest fill. Civil 3D can also automatically prepare and insert a legend to define the coloring.
Summary

Although working with surfaces in Civil 3D is very different from working with surfaces in Land Desktop, there are many benefits. From creation to completion, working with surfaces in Civil 3D is more intuitive, requires fewer steps, and helps eliminate the possibility of error. The following table provides...
a quick review of how Civil 3D solves many of the issues you may have had when working with surfaces in Land Desktop:

<table>
<thead>
<tr>
<th><strong>Land Desktop Limitation</strong></th>
<th><strong>Civil 3D Solution</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you ever created a surface and wished there was some immediate visual feedback to show what you created?</td>
<td>Civil 3D uses surface styles to display your surface from the minute you add your first piece of data to it.</td>
</tr>
<tr>
<td>Have you ever edited a surface and wished your contours would update automatically?</td>
<td>In Civil 3D, the contours are a subset of the main surface object. Editing the surface automatically updates your contours.</td>
</tr>
<tr>
<td>Have you ever wished you could use the standard Undo command to fix a mistake you made to your surface?</td>
<td>Because Civil 3D surfaces are not connected to an external data file, using commands like Undo is not a problem.</td>
</tr>
<tr>
<td>Have you ever had to extensively edit a surface created from contours to “fix” areas not interpolated correctly?</td>
<td>Creating surfaces from contour data in Civil 3D produces significantly more accurate results, thereby reducing the need for extensive manual editing.</td>
</tr>
<tr>
<td>Have you ever wished your contour labels could faithfully be used for multiple scale drawings?</td>
<td>Civil 3D surfaces and labels are dynamic. Changes to drawing scale and rotation will automatically adjust label height and orientation, even when the surface is an xref.</td>
</tr>
</tbody>
</table>

**Alignments and Profiles**

When you work with alignments and profiles in Civil 3D, you’ll notice many differences from Land Desktop. Just as with other features, accomplishing alignment and profile tasks in Civil 3D is easier and more powerful than in Land Desktop. The following section provides a brief description of how you worked with alignments and profiles in Land Desktop.
## Alignments and Profiles in Land Desktop

As with other Land Desktop features, working with alignments and profiles in Land Desktop involves working with, and having to maintain, data in external files or databases:

<table>
<thead>
<tr>
<th>Land Desktop Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alignment Creation</td>
<td>Create alignments from objects or polylines by selecting the desired entity, selecting a reference point, and then giving the new alignment a name and station information. If you are creating from a polyline, you had to guess if it was originally drawn in the direction you need. Once defined, the alignment is created in an external alignment database.</td>
</tr>
<tr>
<td>Station Label Settings</td>
<td>At some point you must establish station label settings by clicking Alignments menu ➤ Station Label Settings. Make choices in the Alignments Station Label Settings dialog box.</td>
</tr>
<tr>
<td>Station Label Creation</td>
<td>Once station label settings are established, create the labels by clicking Alignments menu ➤ Create Station Labels. A prompt asks if you want to delete the old station labels and replace them with the new ones. (Many users have noted that at this point in the workflow, it’s a little too easy to inadvertently delete all the station labels for all your alignments.)</td>
</tr>
<tr>
<td>Profile Settings</td>
<td>Before creating a profile, verify that the profile settings are as desired. These settings control components like sampling, layers, and labels.</td>
</tr>
<tr>
<td>Profile Creation</td>
<td>First set the desired surface and alignment as current, then you can create a Profile from a Surface, from a File, or from Sections. A command line message indicates when the profile is created. The profile data is maintained in an external data file. To view the profile, select Profile menu ➤ Create Profile. After making choices in the Profile Generator dialog box and picking a point in the drawing, the profile is displayed. Moving it, however, can cause problems.</td>
</tr>
<tr>
<td>Land Desktop Functionality</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Vertical Alignment Editing</td>
<td>If you would like to add a proposed (finished ground) profile, you have two options. You can generate the proposed profile graphically (using several tools) or you can use the Vertical Alignment Editor. Both options are available on the Profile menu. If you want to add the proposed profile, complete with labels, to the existing profile, use the Import utility.</td>
</tr>
</tbody>
</table>

Most Land Desktop users are comfortable working with the alignment and profile functionality because it is a process they already know. It does however, have some limitations. For example:

- Have you ever had to reverse the direction of an alignment?
- Have you ever wished you could rename an alignment?
- Have you ever edited alignment geometry and then realized that you now have to recreate the profile?
- Have you ever had to rework a drawing because someone moved your profile?
- Have you ever wished you could create more than one finished grade profile for an alignment?

**Alignments and Profiles in Civil 3D**

In Civil 3D, one of the most significant differences in working with alignments and profiles is that the alignment and profile data exists in the drawing file, not in an external database or file. There are several other significant differences too, such as the fact that Civil 3D alignments and profiles are dynamic objects.

**Alignments**

Just as in Land Desktop, in Civil 3D you can create alignments several different ways. From the Home tab on the ribbon, click Alignments to display the drop-down menu of alignment creation commands. Clicking Alignment Creation Tools displays the Alignment Layout Tools toolbar that lets you create alignments in a variety of shapes, using precision tools to perfect your geometry.
You can also choose Create Alignment From Object, Create Alignment From Corridor, or Create Alignment From Network Parts.

The process of creating an alignment from an object is nearly identical to the create alignment from polyline option in Land Desktop. Once the polyline (or other object) is created, you select it and then use the Create Alignment From Object command to convert it into an alignment.

You can also use the Create Alignment From Network Parts command, which is very similar to the Create Alignment From Polyline command. Use it to quickly create an alignment from an existing pipe network (pipe run) in your drawing.

Creating an alignment using the Alignment Creation Tools (also known as the Alignment Layout Tools toolbar) is a new concept for Land Desktop users. To access the Alignment Layout Tools toolbar, from the Home tab, click Alignment Creation Tools from the alignment drop-down menu on the Create Design panel. When the Create Alignment Layout dialog box displays, enter a name for the new alignment, and then click OK. The Alignment Layout Tools toolbar is displayed.

Basically, you use this toolbar to construct alignments with specific engineering rules or constraints built in. It provides you with a variety of options for creating your alignment.

The advantage of creating your alignment using the Alignment Layout tools is that you can incorporate design criteria directly into your alignment. For example, you can create an alignment that requires that an arc must pass through a particular point. Using this toolbar, you can create complex geometry that would be challenging and time-consuming to construct in Land Desktop.

No matter which alignment creation method you use, you are eventually prompted to enter some basic alignment object creation information, such as name, description, style, layer, label set, and so on.
Another important concept to understand is that after it is created, the alignment itself is an object. As such, by default it contains station labels. Therefore, you no longer have to add them. Because in Civil 3D an alignment object is not connected to an external database, you can edit your alignment as often as necessary without having to go through any re-creation process. For example, in Civil 3D, you can grip edit alignments, as well as all the labels, curves, and bearing/distances associated with it. In Land Desktop, to do the same requires that you update each of these individually.

Have you ever needed to change the length of an alignment part of the way through a project? How about having to rename one? In Civil 3D, tasks like this are no longer an issue. Also, you should note that there is a handy “Reverse Direction” option available by clicking the drop-down arrow on the Modify panel of the Alignment tab.
Profiles

You’ll find that the way you work with profiles in Civil 3D is dramatically different from the way you worked with profiles in Land Desktop. In Civil 3D, a profile is simply a vertical representation of data from an alignment (and a surface). In other words, a profile is more or less a linear object. In Civil 3D, the profile itself does not contain the grid lines, stationing information, and elevations, as profiles do in Land Desktop. Instead, the grid lines, stationing, and elevation data for a profile are stored in a separate, new object type called a profile view. The profile view is simply a container to display profiles. It maintains the data associated with the actual linear profile (the profile object) item, such as the length, start and end points, and station and elevation data of the alignment it represents. It also creates and controls the actual grid in which you display the profile data, along with information such as the bands of data you want to display along the X-axis above or below the grid.

At first glance, this may seem complex, but this methodology actually makes working with profiles easier. For example, using Land Desktop, have you ever wanted to have more than one proposed profile for a single alignment, so that you could show several options for a proposed road design? Land Desktop only allows you one. Below is an example of this concept. It shows the Civil 3D Prospector tree with an alignment called Fescue Drive that contains four profiles (one existing and three proposed).

Below those profile entries are any profile views for Fescue Drive. In this case, there is only one. If you want to compare your Existing Ground to Alternate One, you can create a Profile View to display them together on the same grid. If you would like to compare the Existing Ground to Alternate Two, you can create a second Profile View to display those as well. There are really many ways you could display this data.

Creating Profiles and Profile Views

Now that you have an understanding of profiles and profile views, let’s explore how you create them in Civil 3D. This section explores creating an existing
and a proposed profile, and begins by using the Profiles commands available from the Profile drop-down menu on the Home tab.

For the most part, existing profiles are created using the Create Surface Profile command, and proposed profiles are created using the commands available from the Profile Layout Tools toolbar, which is displayed when you select Profile Creation Tools.

After selecting Create Surface Profile, the following dialog box is displayed:
After selecting the desired alignment and surface, click the Add>> button to create your new Existing Ground Profile in the Profile List. If you look closely at the dialog box, you will see options for controlling which portion of the alignment is sampled, as well as the ability to sample offsets. This is not very different from Land Desktop.

After adding your new profile to the list, you can present it in a profile view by clicking Draw In Profile View at the bottom of the dialog box.

**NOTE** Throughout the process, having to select both the alignment and the surface in the various dialog boxes reduces the possibility of error. It also means you don’t have to worry about what is current and what is not as you do with Land Desktop.

Remember that the profile view is just a container that displays the profiles. Conceptually, you only need to select your alignment and the desired profiles you want to display. After you click Draw In Profile View, Civil 3D opens an easy-to-use wizard that guides you through the process of creating a profile view.
As you step through the choices in the wizard dialog boxes, you’ll be able to configure the following to determine the organization as well as the presentation of your profile view:

**Profile View Name**—To assist in keeping things organized, you must give this profile view a name. As with all Civil 3D objects, you can accept the default name that is displayed automatically, if you wish (for example, PV 1).

**Station Range**—If your profile is very long and you only want to present a small portion of it, you can specify a desired station range.

**Profile View Height**—If you want to provide some additional white space (margin) at the top or bottom of your view, just increase the View Height.

**Profile View Style**—The profile view style controls how the profile view looks. In other words, it defines components such as grid spacing, vertical exaggeration, titles, view direction, and so on.

**Band Set**—Selecting a band set adds preconfigured labeling to the top or bottom of your profile view.

When finished specifying options, click Create Profile View and you are asked to select a point in Model space to display the new profile view. Just as in Land Desktop, you are selecting where the lower left corner of the profile view will be placed.

Once these choices are defined, they can be easily changed using the Profile View Properties dialog box. Just right-click on a profile view and click Properties.
from the right-click menu, or select a profile view in the drawing and then click Profile View Properties from the ribbon.

After the insertion point is selected, the profile view is displayed. Using the Move command on a profile in Land Desktop was problematic, but in Civil 3D it’s not a problem. To move the profile view, you can use the standard AutoCAD MOVE command to relocate it, or use the grip at the lower left corner of the profile view.

It’s now time to create your proposed profile. From the Profiles drop-down menu on the Home tab (ribbon), select Profile Creation Tools. You are then prompted to select which Profile View you will be using to create your new profile. After clicking on the desired Profile View, the following dialog box is displayed:
NOTE  When you are trying to select a Profile View in a drawing, you must make certain that you click on a *grid line* rather than on a *profile line*. The grid lines are part of the profile view object. The profile lines are profile objects. Even though the two object types can be displayed together, it is important to understand that the profile view and the profile are two separate and distinct object types that are displayed on top of each another.

Using this dialog box, you can give your proposed profile a name, and select styles to control how it is displayed and labeled. Accepting the defaults will produce a proposed profile that looks very similar to a Land Desktop profile.

After clicking OK, the following toolbar is displayed. Notice that the Profile Layout Tools toolbar is very similar to the Alignment Layout Tools toolbar. This is another example of the standardized user interface in Civil 3D.

In Land Desktop, you could create proposed profiles graphically, through an editor, or a combination of both depending on the information you have to work with. The next section explores performing the same tasks using Civil 3D.

**Create a Proposed Profile from Scratch Using the Editor**

By clicking the Insert PVIs - Tabular button on the Profile Layout Tools toolbar, a dialog box displays that lets you create the profile by typing in PVI stations, elevations, and vertical curve information. If you look at the top of this dialog box, you'll notice that you can now create asymmetrical vertical curves.
Create a Proposed Profile from Scratch Graphically

You can also use the Profile Layout Tools to create the geometry graphically. You do not draw it using AutoCAD, and then convert it into a profile later, as you did in Land Desktop.

By clicking the `انتشار` button on the Profile Layout Tools toolbar, you can select either Draw Tangents or Tangents with Curves. From the drop-down menu, you can also select Curve Settings to set the defaults. Once the command is initiated, you can simply draw the Proposed Profile. As the profile is drawn, all of the necessary annotation is created automatically.

Define Proposed Profile Geometry Using the Editor

After creating some or all of the Proposed Profile graphically, you can click the Profile Grid View button `إضافة` to open the editor (Panorama window). In the editor, you can create or refine the Proposed Profile geometry.
The column headings are similar to those in Land Desktop. This is another example of where your Land Desktop experience is very relevant. Notice the “Grade In” Column. In Civil 3D, unlike Land Desktop, you can grade in both directions.

Summary

It’s easy to see that creating alignments and profiles in Civil 3D is more powerful and requires fewer steps than in Land Desktop. Also, the use of built-in style features in Civil 3D assists in maintaining standards throughout your organization. Now that you have an understanding of how Civil 3D handles alignments and profiles, let’s review how Civil 3D solves many of the issues you may have had when working with these features in Land Desktop:

<table>
<thead>
<tr>
<th>Land Desktop Limitation</th>
<th>Civil 3D Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Have you ever needed to reverse the direction of an alignment?</td>
<td>You can now quickly and easily reverse the direction of an alignment. Just select an alignment, and select Reverse Direction</td>
</tr>
<tr>
<td>Land Desktop Limitation</td>
<td>Civil 3D Solution</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Have you ever wished you could rename an alignment?</td>
<td>Renaming an alignment in Civil 3D is simple and reliable. Right-click the align-</td>
</tr>
<tr>
<td></td>
<td>ment in the Prospector tree and click Properties. Change the alignment name in</td>
</tr>
<tr>
<td></td>
<td>the Name field and click OK.</td>
</tr>
<tr>
<td>Have you ever had to edit your alignment geometry and as a result had to recreate</td>
<td>Because alignments and profiles are dynamic objects, when you edit an alignment,</td>
</tr>
<tr>
<td>your profile?</td>
<td>the corresponding profiles are automatically updated as well.</td>
</tr>
<tr>
<td>Have you ever experienced undesirable results caused by someone moving your profile?</td>
<td>Profile View objects do not rely on connections to external files. Therefore, they</td>
</tr>
<tr>
<td></td>
<td>can be moved using standard AutoCAD commands.</td>
</tr>
<tr>
<td>Have you ever wanted to create more than one finished grade profile for your align-</td>
<td>In Civil 3D, numerous profiles can be associated with each alignment.</td>
</tr>
<tr>
<td>ment?</td>
<td></td>
</tr>
</tbody>
</table>

### Plan Production

This section explores the plan production features in Civil 3D and compares them to Land Desktop plan production features.

### Plan Production in Land Desktop

Plan production in Land Desktop involves using the Sheet Manager to create plan, profile, plan/profile, and cross section sheets that can be plotted. The process involves many steps. Along the way, if any changes to your model or annotation occur, frequently the plan production (sheet generation) process would need to be started over again from the beginning. In many organizations, these tasks are not started until a project has reached a certain state of completion. This is to avoid having to do the same tasks over and over again as designs evolve.
Plan Production in Civil 3D

The Civil 3D plan production features provide faster, and much more automated functionality than the plan production features in Land Desktop. The first thing that is important to understand is that in Civil 3D, the plan production features are comprised of two wizards that allow you to quickly create sheets along a selected alignment.

The first wizard—the Create View Frames wizard—creates objects called "view frames" which are similar to viewports. This wizard asks you to select an alignment in your model, and to specify some other options. You can accept the defaults, or make changes to them. When the wizard completes, the "view frames" are placed automatically along that alignment.

The second plan production wizard—the Create Sheets wizard—automatically creates sheets from the data that exists within the boundaries of the view frames, and displays it according to choices you make on the wizard dialogs. Both wizards reference templates, which you specify, and which of course also play a part in defining how the data in the sheets is displayed.

Just like the Create View Frames wizard, the Create Sheets wizard takes just a few seconds to use. It is very easy to play around with this feature, creating, adjusting, deleting, and recreating view frames and sheets until plans look just the way you want.

Summary

Now that you've briefly compared plan production features in Land Desktop to those in Civil 3D, refer to the following table for a summary of how Civil 3D provides the more efficient solution:

<table>
<thead>
<tr>
<th>Land Desktop Limitation</th>
<th>Civil 3D Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Land Desktop, creating plan sets is a task that typically must wait till a project has reached a state of near completion. Drafters must wait till designers and engineers give them a green light to begin the plan production phase.</td>
<td>With Civil 3D, plan production tasks can occur simultaneously with many engineering and design tasks. Drafters can begin creating plan sets while designers and engineers are still working on model data. This enables plan production tasks to begin and complete much earlier in the project cycle, reducing the overall project timeline.</td>
</tr>
<tr>
<td>Land Desktop Limitation</td>
<td>Civil 3D Solution</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Have you ever spent hours or days revising plan sets just because minor changes to your model had to be implemented?</td>
<td>With Civil 3D, because plan production features are dynamically linked to your model data, updating plan sets when model data changes can take just a few seconds.</td>
</tr>
<tr>
<td>In Land Desktop, ensuring that plan sets adhere to company standards is a tedious, and error-prone process. Often visual editing or checking is the only way to ensure that annotations and other data are represented as desired.</td>
<td>Because Civil 3D includes style-based objects and labeling, keeping plan sets in adherence with company standards is faster and easier.</td>
</tr>
</tbody>
</table>
Setting Up Styles in Civil 3D

As you adopt Civil 3D, you will want to take some time to understand styles. Using styles provides you with enormous gains in productivity, precision, consistency, and quality.

Styles control the appearance and sometimes the behavior of Civil 3D objects. By using styles in Civil 3D, you have great flexibility in the presentation of design elements, including labels and tables.

This chapter provides an overview of styles, explains how styles fit into the hierarchy of Civil 3D settings, and describes how to get started creating customized styles in Civil 3D.

Overview of Styles in Civil 3D

In Civil 3D, styles control the display of all the visual elements of objects, labels, and tables. Using the styles you create, all elements of the design object are automatically set to a specific linetype, color, and layer reference.

To get the most from Civil 3D, organizations can create customized styles, according to their standards, which, along with various other drawing settings, can be saved in a drawing template file (.dwt) for easy reuse. Having a drawing template with styles that meet your company standards is one of the most important steps you can take to ensure that you have a successful transition to Civil 3D. As mentioned earlier in this guide, you need to make sure to devote appropriate resources to developing styles for your organization.

In Civil 3D, you can apply styles at various levels. For example, you can assign styles at the object level (alignments, profiles, surfaces, pipe networks, and so on), as well as at the object sub-component level (for example, pipes and structures within a pipe network), and even specific styles for the various components of pipes or structures. You can also create styles for object labels and tables. This ability to automatically update objects and labels by simply...
changing a style is a tremendous time-saver over what you must do in Land Desktop to update the appearance of an object.

You can create Civil 3D styles based on a company standard to represent all the phases of a development project. For example, you may have a set of styles that are applied to existing elements, and another set of styles for proposed elements.
Alignment style collection on the Toolspace Settings tab

Toolspace

Active Drawing Settings View

- Alignment
  - Alignment Styles
    - Basic
    - Existing
    - Intersection Basic
    - Layout
    - Offsets
      - Proposed
  - Design Checks
- Label Styles
  - Label Sets
    - Station
      - Major Station
      - Minor Station
    - Geometry Point
    - Profile Geometry Point
    - Station Equation
    - Design Speed
    - Superelevation Critical Points
  - Station Offset
  - Line
  - Curve
  - Spiral
  - Tangent Intersection
- Table Styles
- Commands
Style Considerations

Creating hundreds of styles can seem like a daunting task, but it can be done gradually. Review the default Civil 3D templates and choose one of these templates as a starting place. By modifying the styles in an existing template, you can create a template specific to the needs and standards of your company.

Template choices in Civil 3D

Civil 3D provides two drawing templates (imperial and metric) based on National CAD Standards (NCS):

- _AutoCAD Civil 3D (Imperial) NCS.dwt
- _AutoCAD Civil 3D (Metric) NCS.dwt

They contain many pre-defined styles for typical use in the land development industry, including styles that resemble the ones used in Autodesk Land Desktop. Use one of these templates as a starting point to become familiar with styles.

Who should create styles?

Before you start to develop a catalog of styles for your company, you have to decide what approach to take. The amount of time and money that you can
afford to invest in style development are important factors when considering the following options:

- **Hire a consultant**—If you have well-defined CAD standards in place, you can hire a consultant to create your style catalog. With minimal guidance and using existing work, he or she can create a template with styles that will closely match your existing work. This approach will ease the burden on a CAD manager.

- **Do-it-yourself**—If time allows, and your company wants to have an on-site styles specialist, designate someone in your firm to build styles. This provides an opportunity to develop a strong internal technical resource who will develop competency in using Civil 3D while building styles.

- **Combined approach**—This approach is ideal if you can hire a well-trained consultant to get you started with style development by meeting with your team. He or she can help you set up your basic styles and instruct you about style creation. You can make progress on a project using basic styles and then create or modify styles as needed while work on a project continues. After the initial style development, a designated resource person can continue adding to your style catalog.

**ByLayer or Style**

Another consideration is to determine whether you want the display of objects and labels to be ByLayer or as defined in the style. On the Display tab of the object style dialog box, you can either set up the style to obtain values ByLayer or specify hard-coded values for each object component type. There are pros and cons to consider for each approach.

<table>
<thead>
<tr>
<th>PROS</th>
<th>CONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Values defined in Style</td>
<td>■ Hard-coded display enforces standards.</td>
</tr>
<tr>
<td>■ Fewer layers to manage because many elements are on one layer.</td>
<td></td>
</tr>
<tr>
<td>■ Display of most styles is done through one dialog box and is faster than using the Layer Manager.</td>
<td></td>
</tr>
<tr>
<td>■ Difficult to manage downstream data.</td>
<td></td>
</tr>
<tr>
<td>■ Not intuitive to layer oriented users.</td>
<td></td>
</tr>
<tr>
<td>■ Requires a style for every object component.</td>
<td></td>
</tr>
<tr>
<td>■ Limitations in sharing data with those not using Civil 3D.</td>
<td></td>
</tr>
</tbody>
</table>
### Styles Workflow

This section describes a basic workflow for creating and using styles.

To enforce CAD standards, styles should be managed through a drawing template.

1. Create a drawing template (.dwt) that contains text styles, linetypes, layers, and blocks that are standard for your organization. One way to get started is to modify the styles in one of the .dwt files in Civil 3D. To access the drawing templates, in Toolspace on the Prospector tab, select Master View. Scroll to the Drawing Templates folder.

2. In the drawing template, create styles for objects, labels, and tables. You can start by copying the existing styles in the template and making modifications to resemble your company standards.

3. Adjust the drawing and feature settings in the template so that new drawings based on the template will contain your customized styles.

4. Save the drawing template on a server or some other location that is accessible to all users.

5. When you create new objects, apply the desired styles.

6. Override style settings as necessary for specific objects or labels, to obtain results for unique needs in a project.

7. Use the drag and drop capabilities to drag styles from one drawing into another. You can drag styles between drawing collections on the Settings tab, or into a drawing that is open in the drawing editor.
Styles Hierarchy and Creation

The Settings tab in Toolspace contains all the object style collections. The templates in Civil 3D have pre-defined styles called Standard or Basic for many objects. Standard or Basic styles can be copied and modified to meet specific display requirements. After you create an object style, you can assign the style when you create an object. If necessary, you can change the specified object style by modifying the object properties.

To create a new style

1. On the Settings tab in Toolspace, expand an object collection.
2. Select the object styles collection. Right-click ➤ New.
3. In the Style dialog box, click the tabs and specify settings.
   - All styles have tabs for Information, Display, and Summary, and depending on the object, there may be additional tabs specific to that object.
   - Note that on the Display tab, by setting the View Direction to Plan, Model, Profile, or Section, you can specify different display options for an object or for an object type, depending on the type of view. For example, in plan (2D) views, you may want pipe objects to display as red, but in profile views, you may want them to display as black. Using the View Direction options on the Style dialog box Display tab, you can easily and quickly apply these style decisions.

The default object styles can be controlled at the object level or the command level.

To set style defaults at the object level

2. In the Edit Feature Settings dialog box, expand the Default Styles Property. The default styles for the feature object are listed.
3. Click a cell in the Value column and click ☰.
4. In the feature Style dialog box, choose from the following options:
   - Select a style from the drop-down list.
Label Styles

Using label styles, you can easily annotate design elements. As with objects, if you assign a new label style, labels are automatically updated to reflect the applied style.

The basic process for creating and working with label styles is similar to object styles, but because labels have more attributes, the specifics for label styles are more detailed. However, the user interface for creating label styles is consistent for all objects. Label styles are composed of general label properties, layout parameters, and the display characteristics that apply when a label is dragged to a new location.

Like object styles, label styles are grouped in collections for each feature on the Settings tab in Toolspace. Each object type has several label styles. For example, surface label styles include styles for contours and slope, while alignment label styles include styles for stations and geometry points.
Label styles also have parent-child relationships. You can create a child style that has the same properties of the parent style, but you can make changes to these properties at the child level. Any property you don’t specifically change will be controlled by the parent style.

The General collection in Toolspace contains the Multipurpose collection of styles. These styles are not associated with a specific object. In the General Label Styles collection there are label styles for lines and curves that you can use on Civil 3D objects such as parcels and alignments. In the General Label Styles there is also a label style for Notes which can be used in situations where you need to add a general purpose note that is not attached to a specific object. You create the Note label styles in the same way as other label styles. They also maintain dynamic text sizing based on the viewport scale.

In the Label style collections for Alignments, Profiles, and Sections, you can create label sets. After you define the label style elements, you can group the types together and create a label set to assign to an object.

**The Label Style Composer**

Use the Label Style Composer to create or edit the format and content for label styles. The Label Style Composer has five tabs with the Information and Summary tabs being similar to object styles. You use the General, Layout, and Dragged States tabs to enter the specifics for the elements in a label.
The Information Tab

This tab is where you specify a style name that reflects what the label style will be, for example Parallel With Tick.

![Label Style Composer - Parallel with Tick](image-url)
The General Tab

This tab is where you specify the following visibility and orientation properties:

**Label**—Controls the text style, visibility, and layer for the label.

**Behavior**—Defines the location and orientation of the label.

**Plan Readability**—Determines the text readability in relation to the page.

**Preview Window**—Displays a preview of the selected style.
The Layout Tab

This tab is where you define the object components and their associated text labels. You select a component name in the component list, such as Major Station or Tick, and then specify properties. The list of properties varies, depending on the selected component. For more information about the properties of the Layout tab, see Managing Layout Properties for Labels in the Civil 3D Help.
The Dragged State Tab

This tab controls the behavior of labels if they are dragged from the default location. It has the following properties:

**Leader**—Controls the display of the leader.

**Dragged State Components**—Defines the text display, border elements, text height, and leader attachment.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leader Arrow Head Style</td>
<td>Closed Filled</td>
</tr>
<tr>
<td>Leader Arrow Head Size</td>
<td>2.50 mm</td>
</tr>
<tr>
<td>Leader Visibility</td>
<td>True</td>
</tr>
<tr>
<td>Leader Type</td>
<td>Straight Leader</td>
</tr>
<tr>
<td>Leader Line Type</td>
<td>ByLayer</td>
</tr>
<tr>
<td>Leader Lineweight</td>
<td>ByLayer</td>
</tr>
<tr>
<td>Draggable State Componets</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Stacked Text</td>
</tr>
<tr>
<td>Border Visibility</td>
<td>False</td>
</tr>
<tr>
<td>Border Type</td>
<td>Rectangular</td>
</tr>
<tr>
<td>Background Mask</td>
<td>False</td>
</tr>
<tr>
<td>Border and Leader Gap</td>
<td>0.75 mm</td>
</tr>
<tr>
<td>Text Height</td>
<td>2.50 mm</td>
</tr>
<tr>
<td>Leader Attachment</td>
<td>Middle</td>
</tr>
<tr>
<td>Leader Justification</td>
<td>True</td>
</tr>
<tr>
<td>Leader Color</td>
<td>ByLayer</td>
</tr>
<tr>
<td>Leader Line Type</td>
<td>ByLayer</td>
</tr>
<tr>
<td>Leader Lineweight</td>
<td>ByLayer</td>
</tr>
</tbody>
</table>

Table Styles

You use tables to represent Civil 3D data for points, parcels, alignments, surfaces, and pipe networks. The process of creating table styles is similar to that of objects and labels. For more information on table styles, see Table Styles in the Civil 3D Help.
Tips for Working with Styles

Use the following tips when you start working with styles:

- There are potentially over 300 styles in Civil 3D. Don’t try to create every style at once. Start by modifying a Civil 3D template to create the basic styles for your pilot project and add new styles as necessary.

- While it is important for everyone using Civil 3D to be familiar with styles and their application, in order to maintain consistency in company standards, a best practice is to have one person control the creation and maintenance of the styles template.

- After you create a template that contains your styles, you can use the drag-and-drop functionality to copy styles from the Settings tab into any drawings that were not created with the template.

- You may want to create several .dwt files for the various aspects of a project, for example Grading Plans or Finish Plans.

- The defaults for the display of geometry label text in a drawing are set on the Abbreviations tab in the Drawing Settings dialog box.

- Use the View Direction field on the object style Display tab to set up component appearance for the following types of views: plan (2D), model (3D), profile, and section.
Tools for Moving Land Desktop Data into Civil 3D

This chapter describes the available tools and methods for moving Land Desktop data into Civil 3D.

You may need to move or share data between Civil 3D and Land Desktop. Perhaps you want to move data from a Land Desktop drawing into Civil 3D drawing, or use Land Desktop for some tasks and Civil 3D for others, and move the data back and forth. While the recommended approach is to start with a new project in Civil 3D, you may have situations that require moving Land Desktop data into Civil 3D.

The following is a summary of the ways that you can move Land Desktop data into Civil 3D. Each method is described in more detail in the following sections.

- **Open a Land Desktop Drawing in Civil 3D**—Enables you to view Land Desktop objects in Civil 3D as proxies or as objects.

- **Import Data From Land Desktop command**—Enables you to import surfaces, description keys, alignments, profiles, parcels, and pipe runs from Land Desktop drawings and projects into Civil 3D.

- **Convert Land Desktop Points command**—Enables you to convert Land Desktop points to Civil 3D points.

- **Import a Land Desktop Point Data File**—You can import an ASCII text file or .mdb file of a Land Desktop points database into a Civil 3D drawing.

- **Import LandXML**—Enables you to import LandXML data that you previously exported from Land Desktop.

**NOTE** The process of sharing data between Land Desktop and Civil 3D is not dynamic. Changes that you make to the data in one program will not be automatically transferred to the other program.

Before you begin moving data between Civil 3D and Land Desktop, verify that you are using the same coordinate and unit system to avoid conflicts.
Opening a Land Desktop Drawing

When you open a Land Desktop drawing in Civil 3D, Civil 3D does not convert the data. However, you can view Land Desktop objects in Civil 3D as proxies or as objects.

When you open a Land Desktop drawing in Civil 3D, the following occurs:

- Geometric data, such as contours, quick sections, grading objects, and curve text, are displayed in Civil 3D as Land Desktop objects. For more information, see the Civil Object Enabler Help.
- Geometric data, such as alignments, profiles, sections, pipe runs, hydrology graphs, sheet layouts, and plotted sheets in paper space, remain in the drawing as AutoCAD primitives (lines, arcs, and text).
- Land Desktop labels remain in the drawing as AutoCAD MText components.

Each drawing is associated with various settings that are specific to Land Desktop, which are stored in an external file named <drawing name>.dfm. This data is not brought forward into Civil 3D.

Setup Object Conversion

Civil 3D reads the setup object when the Land Desktop drawing is opened in Civil 3D and translates certain aspects into the Civil 3D drawing settings for the session.

**NOTE** If you close the drawing without saving it, then the original setup object remains intact and you can open the drawing again in Land Desktop.

Some information in the Land Desktop setup object is translated into Civil 3D and some is not, as described in the following table:

<table>
<thead>
<tr>
<th>Land Desktop Setup Object</th>
<th>Civil 3D Drawing Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear units</td>
<td>Translated to drawing units</td>
</tr>
<tr>
<td>Angle units</td>
<td>Translated to angle units</td>
</tr>
</tbody>
</table>
Using the Import Data From Land Desktop Command

To import surfaces, description keys, alignments, profiles, parcels, or pipe runs from a Land Desktop project or drawing into Civil 3D, you can use the Civil 3D Import Data From Land Desktop command.

This command imports the Land Desktop data into the current Civil 3D drawing. Because Civil 3D stores all objects in drawings, the drawing does not have to be associated with a project. However, if you are using the Civil 3D project management features (Autodesk Vault), you can associate the current drawing with a Civil 3D project and check the data (points, surfaces, and alignments) into a specified project.

**NOTE** Data units cannot be converted when using the Import Data From Land Desktop command. Therefore, you must import an imperial-based project into an imperial-based drawing, for example. If you want to convert units during the import, you must use the LandXML import feature.

It is recommended that you import one data type at a time. For example, first import surface data and then repeat the procedure to import description keys or other data types, one data type at a time.
To import data from a Land Desktop project

1. On the ribbon, click the Insert tab ➤ Land Desktop, or enter ImportLDTData at the command line.

2. In the Import Data From Autodesk Land Desktop Project dialog box, enter a valid path, to browse to the project root folder and select a path. For example, C:\Land Projects <version number>.

3. In the Project Name list, select a project from which you want to import data. After a valid project name is selected, the available data that you can import is displayed in the dialog box.

4. Specify an Alignment Site. If you leave the default site at None, the Alignment data is placed in the Alignments collection, rather than in a Site collection.

5. Navigate to the data you want to import.

6. Select or clear the check boxes for one or more of the following features:

   **TIP** To obtain the best results, import only one data type at a time.

   - **Description Keys**: Imports description keys. When you update a drawing template, it is a best practice to select this option.
   - **Surfaces**: Imports surface data.
   - **Alignments**: Imports alignment data.

   **NOTE** To migrate a Softdesk alignment database, you must convert it into a Land Desktop 3.x through Land Desktop 2009 database before importing it into Civil 3D.

   - **Profiles**: Imports both EG (existing ground) and FG (finished ground) profiles.

   **NOTE** When importing a profile without an associated surface or alignment, the profile will be static in Civil 3D.

   - **Parcels**: Imports parcel data that was created using the Land Desktop parcel manager to the specified site.
   - **Pipe Runs**: Imports pipe run data.
NOTE Before importing Land Desktop pipe run data, make sure that the Civil 3D pipe network Parts Catalog (Parts List) has the part sizes that make sense for the pipe network you will be importing. For more information, see Part Catalog and Parts Lists in the Civil 3D Help.

7 Optionally, you may want to create new sites to separate the data. To do this, right-click Sites ➤ New in Toolspace on the Prospector tab. The new site will appear under the Sites collection. You can move parcels and alignments (and associated profiles) by dragging them into different sites.

8 Either click Apply, to iteratively import and check messaging, or click OK.
A message box is displayed, indicating the status of the import. Click OK.

9 Either go to Step 10 or, if you have completed an iterative import process using Apply, click OK.

NOTE Imported objects take on the default style for each object.

10 Verify the data using the following methods:
   - **Description keys**: In Toolspace, on the Settings tab, expand the Description Key Sets collection under the Point collection and verify that the description key files are listed.
   - **Surfaces**: In Toolspace, on the Prospector tab, click the Surfaces collection (for the current drawing) and verify that the new surface is included. (You may need to right-click the feature and click Zoom To to see the surface in the drawing.)
   - **Alignments**: In Toolspace, on the Prospector tab, if you specified a Site in the Import Data From Land Desktop Project dialog box, verify that the site is included. If you did not specify a Site, expand the Alignments collection and verify that the alignments are included.
   - **Profiles**: In Toolspace, on the Prospector tab, if you specified a Site in the Import Data From Land Desktop Project dialog box, verify that the site is included. If you did not specify a Site, expand the Alignments collection and verify that the profiles are included.
   - **Parcels**: In Toolspace, on the Prospector tab, verify that the site you specified for the parcels is included. If you did not specify a Site, expand the Parcels collection and verify that the parcels are included.
Pipe Runs: In Toolspace, on the Prospector tab, click the Pipe Networks collection and ensure that the pipes are included.

Converting Point Data from Land Desktop

In Civil 3D, you can use the Convert Land Desktop Points command to convert Land Desktop points in a Civil 3D drawing to Civil 3D points.

You may choose to use this command if you do not have Land Desktop installed, or anytime you have non-Civil 3D point objects (for example, Land Desktop point objects) in your drawing that need to be converted to Civil 3D point objects.

Using this command, you can set a variety of point settings. For example, you can set default layers, point creation settings, and more for the points you will be converting. You can automatically add the converted points to a newly-created point group or to an existing point group. The existing Civil 3D point number and point name conflict resolution rules are used if a point ID conflict occurs during the conversion.

For more information, see Converting Land Desktop Points in the Civil 3D Help.

To convert Land Desktop points

1. In Civil 3D, on the ribbon, click the Home tab ➤ Create Ground Data panel ➤ Points drop-down menu ➤ Convert Land Desktop Points, or enter ConvertLDTPoints at the command line.

2. In the Convert Land Desktop Points dialog box configure point setting parameters by expanding the parameter, selecting a setting, and then specifying a new value in the Value column.

3. To assign the Land Desktop points to a point group, select the Add Points To Point Group check box, and then either select a point group from the list or create a new point group. If you create a new point group, it is added to the Add Points To Point Group list.

4. To keep the existing layers referenced by the Land Desktop points, select the Preserve Original Point Layer check box.
NOTE When this check box is selected, the existing layer of the Land Desktop point is assigned to the Civil 3D point when it is converted. In the Point Creation settings, if the Disable Description Keys setting is set to False, and the Land Desktop point matches a description key, the original point layer will still be preserved.

5 Click OK.

Importing Point Data from Land Desktop

If you need to import point data from a Land Desktop project, you can import the external Land Desktop point data (database) file into Civil 3D.

Civil 3D can import point data from an ASCII (text) file or a Microsoft® Access .mdb file into a drawing. Before you import points into Civil 3D, you must create a point file format that describes the layout of the point data in the point data file. For more information, see Understanding Point File Formats and Creating Point File Formats in the Civil 3D Help. You can add the imported points to a point group, make adjustments to the data as it is imported, including elevation adjustments, coordinate transformation, or coordinate data expansion, and specify how the imported points are numbered as they are created.

For more information, see Importing Point Data in the Civil 3D Help.

To import point data

1 In Civil 3D, specify the Point Identity settings, which control the point numbers of the created points. For more information, see Editing the Point Identity Settings in the Civil 3D Help.

2 On the ribbon, click the Insert tab ➤ Import panel ➤ Points From File , or enter ImportPoints at the command line.

3 In the Import Points dialog box, specify the point file format that describes the layout of the data in the point data file you are importing.

4 In the Import Points dialog box, select External Project Point Database as the format type and select the Land Desktop point database .mdb file as the source file.

5 Optionally, specify a point group to which the imported points are added.
6 Optionally, specify advanced options for elevation adjustment, coordinate transformation, or coordinate data expansion.

7 Click OK to import the points.

Using LandXML Export and Import

Using the LandXML export and import features, you can export data from Land Desktop and import it into Civil 3D.

The LandXML import and export features are based on the LandXML schema. For detailed information about exporting and importing using LandXML, go to www.landxml.org, or you can refer to the Civil 3D or Land Desktop Help. The following sections summarize how this functionality works.

LandXML Export

Whether you are exporting from Land Desktop or from Civil 3D, the process is similar. To export a LandXML file from Land Desktop, click Projects menu ➤ Export LandXML. The LandXML Export dialog box is displayed. You can choose to export the point, surface, parcel, alignment, and pipe run data from the drawing.

In Civil 3D, you can export data to a LandXML file using the ribbon by clicking the Output tab ➤ Export To LandXML. You can also right-click an object collection in the Prospector tree and select Export LandXML.

In Civil 3D, when you export from the Prospector tree, the Export To LandXML dialog box contains a pre-defined selection set of the data in that collection. When you export using the command available from the ribbon, all drawing data is selected by default, and you can adjust the selection by clearing check boxes. Alternately, you can specify the objects to export by selecting them from the drawing.

The following sections provide step-by-step information on the process.

To export LandXML data from Land Desktop

1 In Land Desktop, either click Projects menu ➤ Export LandXML, or enter LandXMLOut at the command line.
   The LandXML Export dialog box is displayed.
To refine the data selection, use any or all of the Points, Surfaces, Parcels, and Alignments buttons. Each of these buttons displays a dialog box in which you can specify data in the project to export.

To export the selected data, you must select the check boxes next to the buttons. For example, to export pipe runs, select the All Pipe Runs check box. If you clear a check box, then the data is not exported.

If you choose to export surfaces, parcels, or alignments, you can export COGO point references instead of coordinates for the parcel and alignment geometry.

2 Under Export Options, click Data to specify the precision settings for the exported data, the imperial unit foot type, the units of exported angles and directions, and whether to export raw descriptions, full descriptions, or both.

3 Under Export Options, click File and specify the reference location for the schema, the default destination location for the exported LandXML file, and whether to export detailed or minimal XML. You can also specify that the exported file is read-only.

It is recommended to set the coordinate precision to six places when exporting data for data exchange, transfer, or archiving. You can change the coordinate precision in the LandXML Export Data Options dialog box.

To export LandXML data from Civil 3D

1 In Civil 3D, either use the ribbon by clicking the Output tab ➤ Export To LandXML, or enter LandXMLOut at the command line.

The Export To LandXML dialog box contains a data tree, where you can select any of the major data collections for export to the LandXML file.

2 Do one of the following:
   ■ Select or clear the check boxes to filter the data types that you want to export to the LandXML file. Then click OK.

**NOTE** The check boxes have a tri-state display. If only some objects are selected under a collection, the check box is dimmed ; if all the items are selected, the check box is selected ; if all the items below the collection are cleared, the check box for the collection is cleared .
If you want to select data in the drawing and select the objects in the drawing. Press Enter when you finish selecting the objects.

3 In the Export To LandXML dialog box, enter the name of the LandXML (*.xml) file you want to export. Click Save.

**LandXML Import**

After you have Land Desktop data exported to a LandXML file, you can easily import it into Civil 3D using the LandXML Import command. To import data from a LandXML file into Civil 3D, first specify the import settings that control the data for import. Then, select the files and the specific data in the file that you want to import.

The LandXML import functionality automatically handles the conversion between the units specified in the LandXML file and the current drawing units specified in Civil 3D.

It is important to note that LandXML does not transform coordinate systems automatically. Therefore, no specific coordinate system transformation is applied other than what is specified by the translation and rotation settings. For more information, see Translating and Rotating LandXML Data in the Civil 3D Help.

The following section provides step-by-step information on the process.

**To import LandXML data**

<table>
<thead>
<tr>
<th>IMPORTANT</th>
<th>Before importing an .xml file, you must open a drawing, such as a drawing based on a Civil 3D template, that contains Civil 3D styles.</th>
</tr>
</thead>
</table>

1 In Civil 3D, either use the ribbon by clicking the Insert tab ➤ LandXML, or enter LandXMLIn at the command line.

2 In the Import LandXML dialog box, select or browse to the LandXML (*.xml) file you want to import. Click Open.

3 In the Import LandXML dialog box, select a site for the parcels. For the alignments you can specify a site or specify None.

4 The data tree displays each of the major data collections in the LandXML file. Use the data tree to:
   - Navigate to a data collection and view its subcomponents.
Expand the collections. Select or clear the check boxes to filter the data types that you want to import into the drawing. By default, all data components are selected for import.

NOTE The check boxes have a tri-state display. If only some objects are selected under a collection, the check box is dimmed; if all the items are selected, the check box is selected; if all the items below the collection are cleared, the check box for the collection is cleared.

5 Click OK to import the LandXML file.

After you click OK, the data is imported into the drawing. The data components are added to the applicable data collections in the Prospector tree.

As each object is imported, you can use the Event Viewer Vista dialog box to view the status of each operation. For more information, see The Event Viewer Vista in the Civil 3D Help.

Civil 3D Migration Commands Summary

This section provides a quick summary of the Civil 3D migration commands that have just been discussed. Note that in Civil 3D, you can access the migration functionality either from the ribbon (Insert and Output tabs), or by using the following commands at the command line.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImportLDTdata</td>
<td>Imports description keys, surfaces, alignments, profiles, and parcels from a Land Desktop project into Civil 3D.</td>
</tr>
<tr>
<td>LandXMLIn</td>
<td>Imports LandXML data into Civil 3D.</td>
</tr>
<tr>
<td>ConvertLDTPoints</td>
<td>Converts Land Desktop points in the drawing to Civil 3D points.</td>
</tr>
<tr>
<td>ImportPoints</td>
<td>Imports external project point databases into Civil 3D.</td>
</tr>
</tbody>
</table>
Adopting Civil 3D Project Management

Civil 3D includes a range of features for managing your engineering projects. Once you understand these features, you can determine the best data structure and workflow to use in your organization. This chapter takes an in-depth look at project management options and discusses how to implement them in your organization.

Project management is a “big picture” issue that affects everyone on the team. Decisions about your project management system can have extensive, long-term consequences. The first challenge is to gain a clear understanding of the planning decisions required and the information you need to make these decisions.

Visualize how a particular project management system will work when it is fully loaded with design objects, drawings, and staff members sharing files. How do you keep the system flexible and efficient while still protecting the data? A strategy that works fine with a set of 20 drawings in a month-long project can break down in a long-term project with 400 drawings. Fortunately, with Civil 3D, you can start with a simple system and either build it up or trim it down as project requirements change.

Organizing Your Data

The following practices are recommended for any project management system:

- Create a structure of project folders and files so every member of the team can readily find the data files they need, and save all drawings in the right place.

- Apply meaningful, specific names to all files and objects that are shared within a project environment. Default names such as “Alignment – (1)” can be especially confusing, because they can appear in multiple drawings, and have no reference to a real-world object.
Establish written procedures for team members who will regularly access project files. This is particularly important if you are not using Autodesk Vault. Procedures can include the use of templates, naming conventions for files and folders, and notices when drawings are being modified. Encourage team members to communicate anything that might affect others.

For basic design objects such as surfaces and alignments, consider saving one object per drawing for maximum flexibility. This drawing structure enables one team member to open a drawing for edit while other members can operate with read-only copies. However, there are exceptions to this structure. On a small project, you may decide to store several objects in the same drawing if they will always be edited by the same person. For example, it often makes sense to keep a set of related alignments in a single drawing.

Data Storage: Vault or Not

With Civil 3D, you have a choice of data storage mechanisms. Autodesk Vault is supplied with Civil 3D. It provides a secure and comprehensive data management solution, but requires formal database management and usage procedures. In most cases, it also requires a dedicated server.

You may want a simpler system. If so, you can store your projects in folders, and manage them in your own way. You must also establish procedures to ensure that data is not unintentionally deleted or changed. These procedures can be quite easy and safe for a small design team in which people have no need for shared access to many drawings and in which they keep in touch with each other’s activities.

For larger teams with a lot of design objects shared across many drawings, Vault may provide a better solution. To really settle this question, you need to understand your data referencing strategy and object relationships within a typical project.

To get acquainted with Vault, you can install it on a networked server or your own computer, experiment with using it, and review the documentation. You probably want to use Vault if you are interested in any of these features:

- Secure document locks and version control
- Assignment of user roles and file access permissions down to the level of folders within projects
- Automated data backup and restore operations
Project labeling and archiving mechanism

Management of data at multiple geographic sites within a single database structure

Drawing and Object Relationships

For all but the smallest projects, it is a best practice to maintain master drawings of common design objects, such as existing ground surfaces and alignments. These objects can then be referenced into other drawings as lightweight copies of the original, requiring very little space. The practice of referencing also protects the source data from unintentional changes, because the referenced objects are read-only copies. The source data cannot be changed in the host drawing.

The use of references leverages the dynamic relationships between objects. When a source object is edited, these changes automatically flow through all referenced copies in other drawings. You can use three types of referencing with Civil 3D:

- Autodesk Vault
- Data shortcuts
- AutoCAD external references (xrefs)

For more information, see Data Reference Types (page 103) in this chapter.

As you create data references between project drawings, you construct a network of drawings. If you are working on a large project with many people, this network can become confusing and difficult to manage. To reap the benefits of data references, it is important to plan the drawing relationships in advance, and actually create a diagram for the project team to reference.
Three-level project drawing structure

The figure shows a sample project structure. You can use this three-level structure with Vault or with data shortcut projects. The following sections describe how to set up the different levels.

**Level 1: Individual Design Objects**

In the first level of the project structure, set up the source drawings that contain basic design objects, such as existing ground surfaces, alignments, and parcel networks. You can either store each object in a separate drawing, or include several related objects in a single drawing.
**One Object Per Drawing**

Keeping each object in a separate drawing is recommended for large projects. This structure ensures that users can edit objects but does not prevent access to other objects by other users. This isolation of objects also minimizes the possibility of a user editing an object and accidentally affecting other objects in the same drawing.

**Multiple Objects Per Drawing**

Group multiple objects in a single drawing for small projects, or whenever one user is solely responsible for the entire design. For example, you could manage all of the related alignments in a subdivision design in a single drawing, and manage the parcel network in another drawing. This project structure reduces the number of drawings to manage. However, there is a risk of accidental changes to objects.

**Data Referencing**

Use data references between your Level 1 drawings to share read-only copies of objects, such as the existing ground surface. These references can be either Vault references or data shortcuts, depending on your structure.

**Explicit Naming**

For each drawing, create a unique file name and save it to the designated project working folder. It is recommended that you name each drawing with a clear reference to the object it contains (for example, *Maple_Street_Centerline.dwg*). As the number of project drawings increases, the wisdom of using explicit references in the file names becomes more apparent.

---

**Level 2: Base, Linework, and Engineering Drawings**

After you have created the design objects, you can create several types of drawings in Level 2 of the workflow, including base, linework, and engineering drawings.

In a multi-user environment, engineers and designers can reference core project objects into composite drawings, keeping the drawing size small, and ensuring that core objects are not unintentionally modified. At the same time, technicians and drafters can create plan sets and production drawings as required.
Base Drawings
You create base drawings, such as a utility base or grading base, by combining data references from Level 1 drawings. You can use base drawings to show the existing conditions on a site, and then xref this drawing into a site features plan or a plan set.

Linework Drawings
Creating linework drawings is sometimes an intermediate step between developing engineering plans and base drawings. Linework drawings contain the linework and AutoCAD objects (such as lines, text, and blocks) that are used to build or represent existing conditions. Although linework drawings do not include Civil 3D objects, you can still add linework drawings to the project so that you can manage and reference them later on in the workflow.

Engineering Plans
Engineering plans, such as corridor designs, grading plans, or site plans, result from combining design objects to create other design objects for your project. For example, in a corridor model drawing, you can keep the drawing at a manageable size by using data references to bring in the alignment and profile from their source drawing, and the existing ground surface from its source drawing.

Level 3: Production Sheets
After you have developed the relevant base, engineering, and linework drawings, you are ready to create a production sheet or a plan set drawing, such as a plan and profile, utility sheet, or landscaping sheet.

To generate these top-level sheets, xref your base, engineering, and linework plans together into a plan set drawing that can be used for generating layouts with title blocks and final drafting. If you use Autodesk Vault, before you xref these drawings, ensure that their latest versions are in your working folder.

To get the latest version of Autodesk Vault project data
■ On the Toolspace Prospector tab, right-click the project name ➤ Get Latest Version.

This operation pulls the most recent versions of all project drawings and design objects into your working folder. After you have these latest versions, you are ready to create level 3 production sheets.
Create the Plan Set Drawing

Let's assume you are working on a plan and profile sheet. First, create a new drawing, name it, and save it to your working folder. Then, externally reference the appropriate Level 2 drawings, such as base linework, base utility, and base topology. When you create a Level 3 drawing, the Level 2 object data and label styles are display-only. However, you can use Layer Manager to selectively hide and display layers within the Level 2 data.

If you use Vault, be sure to use the option Include All File Dependencies when you check in the plan set drawing. This ensures that all associated file dependencies are copied to their working folders when other team members check out the plan set drawing.

You typically use a plan set drawing with Sheet Set Manager (SSM) in Civil 3D. To create individual sheets in SSM, you create AutoCAD views within your plan set drawings. For more information about SSM, refer to the online help in Civil 3D.

Additional Drafting and Annotation

You can data reference individual design objects into a plan set drawing and apply any required annotation or drafting. This process leverages the work done in Level 1 and Level 2 drawings. In addition, drafters and technicians can finalize the annotation for the Level 3 sheets as part of a full set of construction documents.

Addressing Interference

When drawings from Level 1 and Level 2 are externally referenced into Level 3, you may find that there are annotation overlaps, duplication, or other interferences. You can use Layer Manager to turn off interfering text, or you can create a data reference of the design object in the Level 3 drawing and control its annotation there. Using this approach, the Level 3 drawings can be synchronized to reflect changes that take place in lower levels. While creating references in Level 3 requires some duplicate work, it is negligible compared to the benefit of synchronizing the Level 3 sheets with the original design.

Working with Images

You may need to incorporate an image in a production sheet. For example, a rough grading plan sheet can include aerial photographs. You can attach an image using the External References Manager.
Bypassing Level 2

You may be able to complete some projects without using all three levels of the workflow. In particular, you may not need the intermediate drawings in Level 2. Instead, you may be able to create Level 3 sheets by data referencing individual objects from drawings created in Level 1. You benefit in bypassing Level 2 drawings because you can create labels directly in the Level 3 drawings, and avoid the possibility of generating interference. However, bypassing Level 2 has a downside because you cannot combine objects from Level 1 with design objects such as corridors or utility networks in separate drawings.

Sample Project Structure

The following table shows how you can use data references and external references to share data among the drawings of a typical project.

<table>
<thead>
<tr>
<th>Drawing or File</th>
<th>Data References</th>
<th>External References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey.dwg</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Existing Ground (EG).dwg</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Parcels.dwg</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td>Alignment.dwg</td>
<td>none</td>
<td>Parcel.dwg, Existing Ground.dwg</td>
</tr>
<tr>
<td>Profile.dwg</td>
<td>EG surface</td>
<td>none</td>
</tr>
<tr>
<td>Corridor.dwg (Source dwg for Corridor surface)</td>
<td>EG surface, Alignment, EG profile, Finished Ground (FG) profile</td>
<td>none</td>
</tr>
<tr>
<td>Proposed Grade.dwg</td>
<td>EG surface, Corridor surface</td>
<td>none</td>
</tr>
<tr>
<td>Sections.dwg</td>
<td>Alignment</td>
<td>Corridor.dwg</td>
</tr>
<tr>
<td>Pipes.dwg</td>
<td>Proposed Grade surface, Alignment</td>
<td>Parcel.dwg</td>
</tr>
<tr>
<td>View Frames.dwg</td>
<td>Alignment</td>
<td>Parcel.dwg</td>
</tr>
<tr>
<td>Sheet Compilation.dwg</td>
<td>EG surface, Alignment, EG profile, FG profile, Proposed Grade, Pipe Network</td>
<td>Corridor.dwg</td>
</tr>
</tbody>
</table>

102 | Chapter 5  Adopting Civil 3D Project Management
Data Reference Types

Civil 3D supports three reference types:

- Vault references
- Data shortcuts
- AutoCAD external references (xrefs)

Vault references and data shortcuts can be used for project surfaces, alignments, profiles, pipe networks, and view frame groups. Vault projects can be converted to data shortcut projects, and data shortcuts projects can be converted to Vault projects. AutoCAD external references can be used with any drawing, regardless of contents. Each reference format is explained in the following sections.

Autodesk Vault Overview

Autodesk Vault is the recommended project management option for large design teams working with Civil 3D.

The main database resides on a designated server, such as a file server on the network, and client software is installed on each computer that requires access to the database.

Using Vault, you can share surfaces, alignments, profiles, pipe networks, points, view frame groups, and survey data.

Vault Project Structure

Vault references are used only within Vault projects, and they are restricted to use within a single project. To use these references across multiple project phases or across different engineering projects, you can create folders for separate engineering projects within a single Vault project folder.

### Data Reference Types

<table>
<thead>
<tr>
<th>Drawing or File</th>
<th>Data References</th>
<th>External References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet Set.dst</td>
<td>none</td>
<td>Sheet Compilation.dwg</td>
</tr>
</tbody>
</table>
Subfolders in a Vault project

As shown in the figure, projects NE and NW are within a single Vault project called North. Vault references can link to any object within the North project folder. If you need to extend these references to other projects, create new folders for these projects inside the North project working folder. Replicate the project structure in Vault, using the Autodesk Vault administration tool. You can use subfolders to organize the folders for drawings and documents, but not other project objects, such as the reference links in Prospector or the Vault database files (project.xml, PointsStatus.mdb, PointsGeometry.mdb, Survey.sdb and Survey.sdx).

Advantages of Autodesk Vault

- This robust database management system provides user security, data integrity protection, version control, and backup and restore functionality.
- Vault facilitates design collaboration among large teams and it is easily scalable when a team grows.
- Vault incorporates new features from Autodesk and Microsoft as they become available with software upgrades.
Vault manages shared objects when checking a drawing into the database.

You can use project templates when creating projects in Vault.

An optional multi-site Vault feature supports the sharing of individual vaults by workgroups in separate geographical locations. This feature supports the same data management and backup functionality that Vault provides on a local network.

Limitations of Autodesk Vault

- Vault requires at least double the disk space needed by other project management systems, because all files exist both in the Vault file store, and in one or more external working folders.
- It requires ongoing server administration activities.

Best Practices

- Designate one team member to be trained as a system administrator and to perform administrative duties regularly.
- Assign database access permissions to user groups rather than to individuals. As a result, you can change the permissions for an entire group, or change users' permissions by moving them to another group.

Sample Uses

- Reference a surface and an alignment into a drawing where you want to design a parcel network. The parcel design can read the surface and alignment geometry. You can also apply display styles and labels to the surface and the alignment that are relevant to the parcel design process.

- Reference several profiles and a surface created from a corridor to create a plan set drawing.

Data Shortcuts Overview

Data shortcuts provide complete reference copies of objects that you can insert into one or more other drawings.
If you are unsure about your need for Autodesk Vault, start with data shortcuts. If you decide to introduce Vault later in the process, you can import your data shortcut projects into Vault. In the process, data shortcuts are automatically converted to Vault references.

Data shortcuts can be created only for surfaces, alignments, profiles, pipe networks, and view frame groups. They provide reference links between drawings without the use of a database. When you create data shortcuts from a drawing, they appear on the Data Shortcuts node of the Prospector tree. From this location, you can insert a reference object into another open drawing by right-clicking its shortcut.

![Data Shortcuts node on the Prospector tree](image)

**Shortcuts as they appear on the Prospector tree**

Objects in the consumer drawing can access the geometry of the reference object in the data shortcut. This geometry can be modified only in the source drawing. However, display styles and labels for the reference object can be modified in the consumer drawing.

The working folder represents a single work environment, including the complete set of related drawings and data shortcuts for one or more engineering projects. The Data Shortcuts node on the Prospector tree displays only the shortcuts from the current working folder. Each shortcut is defined in a small XML file, stored in the _Shortcuts folder of the working folder. Most users do not need to work with these XML files.

When an object is updated in the source drawing, notification appears in the main application window and on the Prospector tree.

**Advantages of Data Shortcuts**

- Shortcuts provide a simple, direct mechanism for sharing object data that is based solely on drawings, without the added server space and administration needs of Autodesk Vault. This can be ideal for small teams or small projects.
They offer access to an object’s geometry in a consumer drawing while ensuring that the object’s geometry can only be changed in the source drawing.

Reference objects can have styles and labels that are different from the source drawing.

Reference objects automatically update when you open a file in which you have referenced data.

During a drawing session, you are notified when a source drawing has been modified, both in the Communication Center, and in the Prospector tab of Toolspace.

Limitations of Data Shortcuts

- They cannot provide data versioning.
- They provide no security or data integrity controls.
- Unlike Autodesk Vault, data shortcuts do not provide a secure mechanism for sharing point data or survey data.
- Maintaining the links between the references and their source objects requires fairly stable names and locations on the shared file system. However, most broken references can be easily repaired.

Best Practices

- To minimize broken references, do not move or rename shared objects or their source drawings after creation. You can move an entire working folder.

- If you need to move or rename multiple objects or data shortcuts in a working folder, use the stand-alone Data Shortcuts Editor. Avoid making direct edits in the shortcut XML files, because this can corrupt the files.

- In a network environment, use UNC paths to provide a flexible but accurate path to each working folder.
Sample Uses

- Reference a surface and a pipe network into a drawing where you want to design a grading plan. You can grade to the target surface even though it is just a reference.
- Reference a surface and a related alignment into a drawing where you want to create profiles in a profile view. Using this data structure, you can keep profiles in a separate drawing from the alignment in accordance with the best practice of “one object per drawing”.

External References Overview

An external reference (xref) inserts the entire contents of another drawing into the current drawing as a display-only object.

External referencing is a standard AutoCAD function, using commands XATTACH and EXTERNALREFERENCES. On the ribbon, click View tab ➤ Palettes panel ➤ External References Manager.

You cannot edit objects in the referenced drawing, but you can use Layer Manager to control the display of separate components.

For more information, see “Attach Drawing References (Xrefs)” in the AutoCAD Help User's Guide.

To insert xrefs

- Click Insert menu ➤ DWG Reference and insert a specified DWG into your current drawing.

Advantages of Xrefs

- Xrefs are versatile and easy to use for different DWG types, whether they contain a single object or a complete design.
- Updates to the external drawing appear automatically in the host drawing when the drawing is opened, and notification of updates is provided during the host drawing session.
- You can apply labels to objects within an xref.
- All the content of the reference drawing is displayed, such as a parcel layout, or existing ground surface contained in a base drawing.
- Corridor data is accessible inside an xref. When you create a sections drawing, you can use an xref to bring in the corridor drawing and a data reference to bring in the required alignment.

- Xrefs can be used with either data shortcuts or Autodesk Vault.

- In Vault, an xref DWG is automatically checked into the project along with the DWG that includes the xref. You can check out the xref DWG independently. When Vault is installed, the Xref Manager in Civil 3D also shows the Vault status icons for each DWG.

**Limitations of Xrefs**

- Because xrefs are display-only, they provide no access to object data, such as surface elevations or alignment length. For example, you cannot create a surface profile from a surface in an xref. Both data shortcuts and Vault object references provide access to object data.

- Xrefs provide no inherent security. Anyone can break links by moving or renaming referenced files.

- When a Vault DWG contains an xref, you must perform all Xref Manager user operations in the parent DWG, not the xref DWG.

**Best Practices**

Select Relative Path as the path type when creating xrefs. Where all document users share the same network environment, use UNC (universal naming convention) paths to provide a flexible but accurate path to each referenced file.

Xrefs are best used when you will not need to manipulate objects within the referenced file. For example, when you import drawings of adjoining surfaces into plan sets. Also, xrefs are a good way to display parcels or other polygonal data as an overlay to a design.

**Sample Uses**

- Display a parcel layout within an alignment drawing.

- Display existing ground information within a design drawing.
Display adjoining project phases in a plan set drawing.

For more information on xrefs, see the AutoCAD Help topic Reference Other Drawing Files.

User Access Controls

For any project team, and especially for a large one, you can protect your data by creating an organized system of access permissions to project folders. Typically you assign read-write access at the project level, and then apply restrictions to sub-folders within a project. It is usually most efficient to apply permissions to user groups rather than individuals. For example, your project team could include Surveyors, Civil Engineers, and CAD Technicians.

Figure 3: Group permissions example

Figure 3 uses bidirectional arrows to signify read-write access, and unidirectional arrows to signify read-only access:

- Surveyors are the only ones with write access to the folder that contains land surfaces. The Surveyors have read-only access to the folder that contains drawings of alignments, parcels, and other civil design objects.
Civil Engineers have read-only access to the land surfaces and production drawings, but write access to the civil design objects.

CAD Technicians have read-only access to the engineering design folder, but write access to the production drawing folder.

Access controls of this type are a standard administrative function in Autodesk Vault. You can configure them using the Autodesk Vault administration tool. If you are not using Vault, you can set permissions within the Microsoft® New Technology File System (NTFS), using the Sharing and Security settings at the folder level. Consult with your system administrator to set up an effective strategy. For any such strategy, it is a best practice to create several user groups or roles and configure the folder access for these groups. Then you can add individual users to a group to acquire the appropriate permissions, and move them to another group, as required.

Project Folder Structure

The structure of project folders is designed to keep all your documents organized and easy to find for all team members. As the number of drawings and other documents increases, the folder structure becomes more important for maintaining productivity and ensuring that nothing gets lost. The data references between drawings include path names, so you must maintain the names and folder locations of the drawings to preserve the references.

Autodesk Vault Projects

If you use Autodesk Vault, each time you create a project you are offered the choice of a project template, which is a standard hierarchy of named folders. It is recommended that you examine the default template (_Sample Project) and either use it or create a modified version to suit your project needs. The default location for project templates is C:\Civil 3D Project Templates.
To create your own template, copy the default version, modify the folder names and hierarchy, and save it in the same directory with a different name.

**Data Shortcut Projects**

If you use data shortcuts, a standard project folder structure is still a best practice. You can use the default template (_Sample Project) and create your own versions.
Keep the top-level _Shortcuts folder and its object-specific subfolders as the storage location for shortcut XML files, but feel free to create other folders for drawings.

**Working Folder Location**

Projects in Autodesk Vault and those with data shortcut references each use the concept of a working folder for storing all projects. For data shortcut projects, the working folder contains the actual project documents. For Autodesk Vault, the working folder contains replicas of original documents from the database.

The default working folder location for both types of projects is `C:\Civil 3D Projects`. This location is fine if you use either Vault or data shortcuts for all your projects. However, if you work with both types of projects, you should keep the project types separate for ease of administration. One simple solution is to name your Autodesk Vault working folder `C:\Civil 3D Vault Projects` and name your data shortcut working folder `C:\Civil 3D Shortcut Projects`.

**Sharing and Transferring Files**

You can use several strategies for sharing files between members of a project team, sending files to clients, and archiving files.

**Project Import and Export**

Autodesk Vault provides a convenient mechanism for safely moving projects between vaults. You can select a project on the Prospector tab and export it to a single ZIP archive. This archive can be transferred as required, and then
imported into another vault. Access the import operation on the Projects node of the Prospector tab. In addition to importing Vault projects, the import operation can import a data shortcuts project and convert all shortcuts to Vault references.

If you have a few drawings with data shortcuts and want to add these to a Vault project, you can simply add them using regular Vault operations. Broken references will be detected, and after all related drawings have been added, these references will be resolved.

**eTransmit**

Use this standard AutoCAD function to send Civil 3D drawings and referenced objects to a client or remote team member. eTransmit is also useful for transferring drawings from one project to another. All drawings required to support the data references are automatically included in the package. The receiving computer must have the Civil 3D Object Enabler installed, or a full version of Civil 3D.

**TIP** eTransmit is ideal for submitting finished drawings or conducting technical reviews with markups. It can also capture edits to the main drawing, and update the central version. However, edits to the referenced drawings are less reliable.

**Autodesk Vault Setup**

If you use Autodesk Vault, you need to make several decisions about the configuration of vaults and projects. These are described in the following sections.

**Single or Multiple Sites**

Choose a network architecture to match the spatial distribution of your team.

You can configure Autodesk Vault for a single office site as shown in the following figure.
Autodesk Vault can also manage project data for users at multiple sites as if they were all working in the same office. This capability is provided by a multi-site option, available with Autodesk Vault at extra cost.
Multi-site Vault architecture

As shown in the figure, a multi-site Vault installation uses a single instance of SQL Server to manage files for two or more sites. Each database—also referred to as a “vault”—is typically replicated at each site to facilitate file sharing, but not all files are copied. Individual files are distributed to users as needed. SQL Server keeps track of where copies of files exist and ensures that these are updated or that users are notified of changes. Database administration tasks for the entire network can be managed from any location.

If your business is distributed across several office locations, the data management and security benefits of multi-site Autodesk Vault may be very useful. For more information, see the Autodesk Data Management Server Implementation Guide.
Creating Additional Vaults

Determine the optimum number of vaults for your projects.

When you first install Autodesk Vault, you automatically create a single vault. This can serve as your “sandbox” or test database for experimenting with Vault operations. Work with sample data that you can practice deleting and restoring without worrying if something gets lost. It is a good idea to retain this test vault for ongoing purposes of training staff and testing new operations.

Your database administrator uses ADMS Console to create a new vault for real project data. Each vault can store many projects, so you may not need more than one new vault. The key point to remember about vaults is that they are separate databases. Each user can log into only one vault at a time. Backup schedules and other administrative operations are configured separately for each vault.

It is a good idea to create separate vaults for separate teams that do not share data. Recommended times to create a new vault for a single team are as follows:

- When your existing vault is getting so large that administrative tasks are very time-consuming
- When you start a new set of projects that do not require data from the older projects

If necessary, you can export a project from one vault and import it into another at any time.

Single Vault

The simplest way to organize your projects with Autodesk Vault is to use a single vault to store all projects and their information. All team members have access to this one location; you set up access control and user names only once. A single vault keeps project data centralized and easier to manage.

Using a single vault for all projects makes sense for a small single office or teams that are connected through a local area network (LAN). Using a single vault, you reduce both your IT and project management overhead. If your organization has multiple offices connected through a wide area network (WAN), you can still employ a single vault, but with multiple sites. For more information, see Single and Multiple Sites.

However, a single vault can become unwieldy over time. As the amount of project data increases, so do the time and space required for backup and
administration. As your vault grows, you may need to archive some older projects, or create a new vault for new projects.

**Multiple Vaults**

Using multiple vaults right from the beginning is recommended for large organizations with several departments that use Civil 3D independently. Each department—such as the survey, site, or highway departments—gets its own vault. This structure makes it easier to separately manage departmental permissions and project access.

Each vault can have a separate system administrator, and users can be granted access to only one vault, if necessary. If some users need access to multiple vaults, you must configure their permissions separately for each vault. Also note that users cannot log into more than one vault at a time.

Organizations with very large, multi-phased projects may want to assign a separate vault for each project, for ease of project management. If you elect to partition your data into multiple vaults on a server, your project teams will see shorter project lists and have tighter control over data access. However, there are some disadvantages. Projects reside in different locations and your users have to remember multiple vault names and locations. Also, backing up and maintaining multiple vaults is more work for your IT department.

**Project Folders**

Create folders to organize your data and to support referencing.

Within each vault, you can create any number of project folders, each using a project template, which is a standard hierarchy of folders. These Vault projects do not necessarily correspond to separate engineering projects. The key point here, as noted in Vault References, is that each drawing can be associated with only one project, and data references must remain within a project folder. Each Vault project should include all of the engineering projects that need to share data. You can always move documents between projects by eTransmit.

**Working Folders**

Understand how to use your local storage location for work in progress.
Drawings and other files stored in Vault are replicated on your local computer or network in what is called a working folder. The hierarchy of folders and subfolders is identical in the two locations.

**Initial Drawing Save Location**

When you create a new drawing, it is a best practice to save it in the appropriate working folder. For example, if you add a new alignment drawing, save it initially to the project subfolder that includes the other alignments. The reason for doing this is that when you later add the drawing to Vault, it will be automatically directed into the correct project subfolder.

**Working Folder Configurations**

You can set up working folders on each client computer or on the network, as described in the following sections.

**Local Working Folders**

![Diagram of local working folders]

When working folders are kept on local computers, as shown in the figure, it minimizes network traffic and accommodates team members who may work
offline from the field or a home office. Users create network traffic only when they check files in or out from the vault.

The disadvantage of this option is that the project files are stored on the local machine, making them unavailable for the backup system. In addition, using external references (xrefs) and Sheet Set Manager (SSM) to share files is a more manual process. This set-up also requires storage capacity on each local machine to accommodate the working folder.

**Individual Network Working Folders**

By maintaining individual working folders on the server, as shown in the figure, you protect each user’s work-in-progress from changes by other users. Locating these folders on the server allows for nightly backup of the data.

The drawback to having individual working folders on the server is the increase in network traffic. Additionally, if you do a nightly backup of the folders, you may have a lot more data than you really need, because you may back up multiple copies of the same files in each folder.
Shared Network Working Folders

Multiple users can share a single working folder, as shown in the figure. This configuration may be more familiar, because many organizations already use a centralized data or projects folder for their drawings. In the same way you regularly back up individual working folders located on the server, you can back up a shared working folder, ensuring project data security. However, since it is a common location, the backups will be smaller in size than the backups of individual working folders.

The benefit of this configuration is that drawings with data references or external references are notified and updated every time they are saved, rather than only when they are checked back into the vault, as with the other two options. The disadvantage of the common working folder is that accidental changes can occur more easily when users work with files in the same set of folders. This approach is recommended only for small teams with members who are in close communication with each other and unlikely to be working in the same drawings.

Autodesk Vault Project User Interfaces

Work with Autodesk Vault from within Civil 3D, or use a separate administration tool.

Within Civil 3D, you can use the Toolspace Prospector tab to interact with Autodesk Vault. Another method is to use the Autodesk Vault administration...
tool. In some situations, there are distinct advantages to using one of these methods over the other. You can also check Vault files in and out from some Microsoft Office applications.

**Prospector Tab**

You can manage project files and records most reliably when you use the Toolspace Prospector tab to create all projects. After you create a new project, it is displayed in the Projects collection in Civil 3D. Also, on the Prospector tab, you can view, edit, and manage drawings as well as Civil 3D object data stored in a vault.

You should use a project template to create a standard folder structure for all of your projects. The template “_Sample Project” is provided with Civil 3D and stored by default in C:\Civil 3D Project Templates. If this template does not meet your needs, simply copy it, revise the folder names and structure, and save it with a different name in the Civil 3D Project Templates folder. Then, when you create a project, you can select your custom template. You can easily make multiple templates for different project types.

**Autodesk Vault Administration Tool**

Autodesk Vault provides a stand-alone application that you can use to manage project files and users. The Autodesk Vault tool window, shown in the figure, uses a table to show project files and data about these files.

![Autodesk Vault window](image)

In the tool window, you can see all project files, including system files such as *project.xml*. 

122 | Chapter 5  Adopting Civil 3D Project Management
The window also lists all drawings where the selected file is used as a reference and displays DWF™ versions of the drawing files, so you can quickly find the version you need.

You can use the Autodesk Vault tool to conduct many administrative activities. An Autodesk Vault administrator can delete unwanted files, set up working folders, and manage file access for individual users or groups, as described in User Access Controls.

Using the Vault tool, you can restore a previous version of a file without restoring the entire project. If you need to create a new drawing using an existing drawing as the basis, use the Copy Design option in the Vault tool to do this without opening the source drawing.

**Project Labeling**

Using the Autodesk Vault tool, you can also label project milestones for easy identification. Firms often need to submit deliverables to a client at certain levels of completion, such as 30%, 50%, and 75% completion intervals. For a 30% complete submittal, you can label all drawings in a project 30%. When you create this new label, it is assigned to the most recently checked-in version of every file in the project and all reference files. If, at a later time, you need to restore the 30% completion project files, you can easily restore the project to this milestone by simply restoring the 30% label, instead of doing it drawing by drawing.

**Pack and Go**

Another helpful administrative task using the Vault tool is Pack and Go, in which a label and all of its referenced files are combined into a single package and sent to either a folder outside the vault or an e-mail address. All files referenced by a selected label are automatically included in the package unless otherwise specified.

Use Pack and Go functionality to do the following:

- Archive a file structure
- Copy a complete set of files, retaining links to referenced files
- Isolate a group of files for design experimentation
- Send a data set to e-mail recipients, such as subcontractors or clients

Because Autodesk Vault allows you to store every file related to your project, such as Word documents, e-mails, and spreadsheets, you should also use the Vault tool to manage files that are not Civil 3D drawings.
It is not recommended that you use the Vault tool on a regular basis to check in or check out drawings with Civil 3D data. In rare cases when these drawings do need to be managed—for instance, if files are lost when checked out of a project—an administrator can force a check-in of the files through the Autodesk Vault tool.

**Microsoft Office**

When Microsoft Office is installed on the same computer as Civil 3D and an Autodesk Vault client, the file menu for these three Microsoft applications is automatically customized for Vault access. An Open From Vault command and an Autodesk Vault submenu are both added to the Office button, as shown in the figure.

![Vault menu added to Microsoft Word](image)

Using these commands, you can log in to Autodesk Vault and work securely with documents without leaving the Microsoft application window.
The Next Move

Now that you have explored the issues involved with moving from Land Desktop to Civil 3D, you may be wondering what your next step should be.

If your organization has already made the commitment to move from Land Desktop to Civil 3D, the next step may already be clear. Teams and individuals may be ready to move on to exploring other training resources, like those listed in Chapter 1. Or perhaps you are ready to contact your Autodesk representative for guidance.

If you still need to convince others in your organization that making the move is the way to go, pointing them to this guide may be the next step.

If you are ready to begin your first Civil 3D pilot project, you will be joining the many other Autodesk customers who are happy they made the switch from Land Desktop to Civil 3D.

Learn More or Purchase

Access specialists worldwide who can provide product expertise, a deep understanding of your industry, and value that extends beyond your software purchase. To purchase AutoCAD Civil 3D software, contact an Autodesk Premier Solutions Provider or an Autodesk Authorized Reseller. To locate the reseller nearest you, visit www.autodesk.com/reseller. To learn more about AutoCAD Civil 3D, visit www.autodesk.com/civil3d.

Autodesk Services and Support

You can accelerate your return on investment and optimize your productivity by using the innovative purchase methods, companion products, consulting services, support, and training that are available from Autodesk and Autodesk authorized partners. These tools are designed to get you up to speed, keep you ahead of the competition, and make the most of your software purchase—no matter what industry you are in. To learn more, visit www.autodesk.com/civil-support.

Autodesk Subscription

Autodesk® Subscription gives you the benefits of increased productivity, predictable budgeting, and simplified license management. You get any new upgrades of your Autodesk software, and any incremental product enhancements, if these are released during your subscription.
term. You also get exclusive license terms that are available only to subscription members. A range of community resources, including web support direct from Autodesk technical experts, self-paced training, and e-Learning, help extend your skills. Autodesk Subscription is the best way to optimize your investment. To learn more, visit www.autodesk.com/subscription.
Index

2D Drafting & Annotation workspace 29

A
alignments
  comparing 53
  creating 56
  features 6
  importing 85
  in Land Desktop 54
  layout tools 56
AOTC (Autodesk Official Training Courseware) 13
Autodesk Land Desktop
  importing points from 89
Autodesk Official Training Courseware (AOTC) 13
Autodesk Vault 5
  administration tool 122
  and Microsoft Office 124
  configuration 114
  multi-site 116
  multiple vaults 118
  project interfaces 122
  working folder options 119

B
best practices
  Autodesk Vault 114
  project management 95
  Best Practices Guide 12

C
Civil
  object enablers 84
  Civil Design workspace 29
  Civil Engineering Community 14
  contours
    labeling 49
  coordinate system 83, 85
  corridors 6
  culvert analysis 7
  curve calculator 32

D
data
  referencing 97
  data compatibility 4
  data sharing 3, 83
  data shortcuts, XML files 106
  description keys 85
  Design workspace 30
  detention pond modeling 7
  documentation 12
  dynamic model-based design 1, 3

e-Learning 13
earthwork 50
eTransmit and project files 114
exporting data 90–91
extensions
  hydraulics and hydrology 7

F
file management 5
folder permissions 110

G
Google Earth 4
grading 7

H
Help system 12
hybrid pilots 11
Hydraflow Express 8
Hydraflow Hydrographs 8
Hydraflow Storm Sewers 7
hydraulics and hydrology
features (extensions) 7

I
importing data 83, 90, 92
interference checking (pipes) 7
IT resources 9

L
Label Style Composer 77, 79
labeling
contours 49
Label Style Composer 77
styles 76
Land Desktop
Civil Design workspace 29
comparing
alignments and profiles 53
menus 28
points 33
surfaces 41
terminology 15
alignments 16–17
general 16
grading 18
inquiry 18
parcels 20
pipes 20
plan production 21
points 22
profiles 22
survey 23
terrain (surfaces) 24
utilities 24
user interfaces 25
workspaces 28
converting points 88
coordinate system 83
importing 85
importing points from 89

Land Desktop Complete
workspace 29
Land Desktop workspace 29
moving data 83
object enablers 84
setup object 84
Survey workspace 29
Land Desktop Complete workspace 29
Land Desktop workspace 29
LandXML 83, 90, 92
Lines/Curves menu 30

M
menus
comparing 28
Lines/Curves 30
model-based design 1
moving data 83

N
New Features Workshop 13

O
object enablers 84
objects
converting 84
Land Desktop setup object 84

P
parcels
features 6
importing 85
pilot projects 9–10
pipes
features 7
importing 85
plan and profile sheets 3
plans 3
points
comparing 33
creating 37
Index | 129

editing 38
features 5
importing 85, 89
in Land Desktop 33
Point Group Properties dialog box 35
point groups 40
preparing for the move 8
profiles
comparing 53
creating 58
features 6
importing 85
in Land Desktop 54
layout tools 63
profile view 58
project management 3, 5
best practices 95
data referencing 97
eTransmit 114
links between drawings 97
project import and export 113
project templates 111
user permissions 110
using Autodesk Vault 114
working folder 113
project structure, three levels 97
project template 111, 122

R
rendering 4, 7
ribbon 26
rotating pilots 10

S
sections 7
shared knowledge pilots 11
Skill Builders 14
standards 2
storm sewers 7
Style Creation
ByLayer 73
ByStyle 73
styles
benefits 2
considerations 72
creating 73, 75
defaults 75
development 72
dependency 75
eTransmit 114
tips 82
workflows 74
subassemblies 6
subscription 14
surfaces
calculating earthwork 50
comparing 41
contours 49
creating 43
editing 46
features 5
importing 85
in Land Desktop 42
style 45
survey features 8
Survey workspace 29

T
tables 81
Task-based Geospatial workspace 30
templates 2, 69, 72
Tool-based Geospatial workspace 30
training 11
training programs 13
tutorials 12

U
User’s Guide 12
<table>
<thead>
<tr>
<th>V</th>
<th></th>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vault</td>
<td>5</td>
<td>watershed analysis</td>
</tr>
<tr>
<td>advantages</td>
<td>104</td>
<td>white papers</td>
</tr>
<tr>
<td>best practices</td>
<td>105</td>
<td>workflows</td>
</tr>
<tr>
<td>limitations</td>
<td>105</td>
<td>styles</td>
</tr>
<tr>
<td>Vault references</td>
<td>103</td>
<td>working folder location</td>
</tr>
<tr>
<td>visualization</td>
<td>4</td>
<td>workspaces</td>
</tr>
<tr>
<td></td>
<td></td>
<td>XML data shortcut files</td>
</tr>
</tbody>
</table>